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Chapter 1: 
Set-up Procedures 

Setting up the Host PC 

Memory and RAM Disk Requirements 

The minimum memory required on the Host PC is in the order of 500 KBytes.  While most 
desktop or laptop PCs are configured with the standard 640 KBytes, this lower requirement 
allows other Terminate and Stay Resident modules to occupy some of the RAM.  

The free disk space requirement depends on the volume of data to be kept on-line.  However, 
over and above this, five megabytes  are required at run-time for the GyHost program to run 
efficiently. 

Directory SetUp 

The GyHost program should reside in a directory named GyHost.  This directory may be on 
the root of a disk drive or be a sub-directory of another directory.  All the files required to run 
both the GyHost and GyHand (now called Gy) programs reside in the GyHost directory with 
the exception of DOS or other utility programs.  A sub-directory named HandHeld is required 
under GyHost to act as a repository for data to be transferred to and from the physical 
HandHeld computer.  If this directory is not present, it will be created when GyHost is started 
up.  The contents of the HandHeld directory are not maintained and are only relevant during 
the UpLoad or DownLoad processes.  At all other times, this directory's contents are 
irrelevant. 

The steps required to create the Host PC directory and load in the system from the system 
distribution diskette are: 

• Make the directory under which the GyHost directory is to reside the current directory 
(this will likely be C:\) 
CD\ 

• Create the GyHost directory thus: 
MD GyHost 



 

2 GyHost/GyHand: A Data Collecting, Editing and Reporting System Version 2002 

• Make GyHost the current directory: 
CD GyHost 

• Insert the distribution diskette which contains the complete system (GyHost02.ZIP,  
Install.CFG,  and Install.EXE) into the A (or B) drive.  Install the GyHost system by 
typing A:INSTALL. 

 
Note:  This software is readily available for download from the TIB website listed below:  
• http://srmwww.gov.bc.ca/tib/software/gyhost/maindoc.htm 

The GyHost directory together with the necessary files and sub-directory has now been set 
up.  The contents of GyHost can be compared to the lists given in the following sub-section.  
However, some of the files named in the following sub-section may not be present since they 
are created when the GyHost and/or Gy systems are used. 

 
DOS StartUp Files 

CONFIG.SYS in Windows95 and 98 

The CONFIG.SYS file on the Host PC must contain the following two lines: 

buffers=24 

files=249 

The buffer's parameter should be a multiple of 8 (necessary for some versions of DOS) and 
be at least 24. 

The files parameter should be an ODD number and be at least 199 (recommend 249). 

CONFIG.GYO in Windows NT 

The contents of CONFIG.GYO and set up procedures under Windows NT 4.0 and 
XP are described in Chapter 4. 

Operational notes 

Note the following when using the GyHost system: 

• GyHost automatically re-indexes the databases when necessary following UpLoad, 
DownLoad and DataTran data transfer so the user does not have to be concerned with 
this. 

• The batch file for executing GyHost is GyHost.BAT.  Following the running of GyHost, 
the batch file deletes all files that have no extension (i.e.  ABCDEF.).  This is a 
precautionary step but means that the user must not rely on any user files with no 
extension being retained in the GyHost directory. 
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• It may be required to remove all the samples in the GyHost directory.  To do this the 
program is invoked as follows: 

GyHost PURGE<Enter> 

****Caution:  this will erase all samples from the GyHost directory **** 

Setting up the HandHeld PC 

Memory and Disk Requirements 

Any HandHeld must be equipped with at least 2 MBytes of RAM Disk.  The RAM Disk, 
drive C: is initially set up with a sub-directory named 'DOS' which contains many DOS utility 
programs in read-only memory.  These programs cannot be deleted. 

A sub-directory GY must be created on the C: drive.  This will be the directory in which 
GyHand will operate and in which all of the Growth & Yield specific information is to be 
kept.  If this directory does not exist, carry out the following procedures: 

CD\ This makes the root directory on the current drive the current 
directory. 

MD GY This creates the GY directory. 

CD GY This makes the directory GY the current directory. 

The GY directory receives the sample data from the host PC for field work, maintains the 
samples through the GyHand program, and is the source of the data sent back to the host PC 
upon completion of the field work.  With the necessary programs and program files set up in 
the GY sub-directory, but with the databases essentially empty, there should be available in 
excess of 643 KBytes of RAM Disk. 

Keyboard Requirements: 

In addition to the normal number and alpha keys, GyHand requires the following keys: 

<Esc> Normally used for escaping from the current to the previous screen 
without updating .  Exceptions are some Browsing screens.  In case 
of an ERROR/WARNING, <Esc>will return the cursor to the 
problem field. 

<F1>, <F2>, <F3>, <F4>, <F5>, <F6>, <F7> 
These are the Hot-Keys, single key operation  that are desirable.  The 
Husky FS/2 has single keys for F1 - F4; F5 – F7 are available by 
pressing  the Paw Key + the '5', ‘6’ or ‘7’ key. 

Lower case alpha, and, if required by the user, upper case as well. 
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DOS StartUp Files - Config and Autoexec 

CONFIG.SYS 

The CONFIG.SYS file on the HandHeld PC must contain the following 2 lines: 

buffers=24 
files=79 

The buffer's parameter should be a multiple of 8 (necessary for some versions of DOS) and 
be at least 24.  The files' parameter should be an ODD number and be at least 79. 

AUTOEXEC.BAT 

The AUTOEXEC.BAT file on the  Husky HandHeld PC must contain the following lines: 

 
path c:\;c:\dos 

prompt $p$g
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Chapter 2: 
Functional Overview 

Data Collecting, Editing and Reporting System Overview 

The Sample Data Collecting, Editing and Reporting System for the Growth and Yield Database 
comprises a Desktop Personal Computer system, a HandHeld Computer system, and the necessary 
communications processes to link these and the Ministry Growth and Yield Database together. 

 

 

 

 
All the database files used in this system are flat ASCII files termed 'SDF' (System Data Format) 
with fixed length records, each record being delimited with a 'return/linefeed' character pair. 

The smallest unit of data that is handled externally to the GyHost and GyHand programs is the 
Sample.  Samples may be moved between the Ministry database and the GyHost system or 
between the GyHost system and the HandHeld PC system.  

The flow of data through the system depends on whether the Samples are re-measurement or 
establishment, each of these two cases will be discussed separately here to aid in understanding the 
process. 

Gy  Hand 
Running in 

Hand Held PC 

Ministry 
Growth & Yield 

Database 

Gy  Host 
Running in 

Desk/Lap-Top PC 
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Data-Flow for Establishment Samples: 

• No data is received from the Ministry for these samples. 

• The Samples are created using the GyHand system.  No tree information can be originated 
using GyHost. 

• The HandHeld system is used to identify the trees in the sample and record the measurement 
data. 

• Upon completion of the collection activity, the establishment data is uploaded to GyHost using 
the UpLoad option.  The UpLoad facility will first delete those records on GyHost relating to 
the samples to be uploaded, and then perform the UpLoad. 

• The uploaded samples can be viewed with GyHost. 

• If the sample data is to be returned to the Ministry at this time, it can be exported to diskette in 
ASCII format. 

Data Flow for Re-Measurement Samples: 

• The previous measurement data together with non-measurement specific data is received from 
the Ministry in ASCII format.  There will not be any records in the Current Sample 
Measurement database (SP_MEAS.DBF).  There will, however, be one record for each 
previously measured sample in the Previous Sample Measurement database 
(PSPMEAS.DBF). 

• The Data Import option is used to bring the previous measurement information into the 
working directory on the GyHost system in Clipper database format. 

• The remeasurement database is downloaded to the HandHeld system using the GyHost 
DownLoad option for the specified samples.  All data relating to each selected sample is 
downloaded. 

• The HandHeld system is used to identify the trees in the sample and record the remeasurement 
data. 

• Upon completion of the collection activity, the establishment and re measurement data is 
uploaded to GyHost using the UpLoad option.  The UpLoad facility will first delete those 
records on GyHost relating to the samples to be uploaded, and then perform the UpLoad. 

• The uploaded samples can be viewed with GyHost. 

• If the sample data is to be returned to the Ministry at this time, it can be exported to diskette in 
ASCII format. 
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The External Interface between GyHost and the 
Ministry's Standard Edit Format 

The files comprising this interface are as follows: 

ACCESS DOT SP_MEAS TR_MEAS SAMPLE 
PLOT PSPMEAS TREE SPECIES 

They have a three character extension, the first character of which will indicate the sample type 
(G, T, I etc.).  The second and third characters are numeric and indicate multiple diskettes (i.e., 01, 
02, 03 etc.). 
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Chapter 3: 
GyHand - The HandHeld System 

Introduction 

The sequence of the HandHeld (H/H) software was designed to imitate, as much as possible, 

the logical sequence of data collection in the field. Therefore, the sample identification and 

plot size must be entered before any tree can be measured. In the same way, a sub-plot tree 

cannot be measured before the sub-plot size is known. 

It is recommended that the logical sequence built into the software be followed in order to 

take full advantage of it. 

The H/H normally retains information that was last entered in some fields. Therefore, when 

first turned on, one may find the region, compartment, etc of a sample completed days before. 

To override this, simply enter the new data to change the identity for the sample required. 

<F1> while the cursor is on any of the sample ID fields, will bring up a list of all samples 

in the system. 

Other features 

<Esc> normally used for escaping from the current to the previous screen without saving.  

< Y > will save the data of an active screen when the message Screen O/K (Y/N) appears. 

< N > will return cursor to the first field at the top of the screen. 

<  or  >   up and down arrows will allow movement around the screens. 
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GyHand Screens 

HandHeld Screen Structure Chart 
Version 2002 (02.06.01) 

Main

Menu

I.D.
Samples

I.D.
Plot

I.D.
Tree Confirm #

Sectors in Plot

Identify
Measurement

Plot
Data

Stump

Sub-Plot/
Dot Count

Stem Map
Plot

Sample
Tree Menu

Dot
Count

Stem Map
Productivity

Sample
Composition

Verify
Completeness

Verify Screens

#131 - #138

Stand
Structure

Dead Tree
Attributes

Path
Remarks

Damage
Agents

Damage
Agents

Productivity
Scar

Selected Sample

Selected

Tree
Height

Tree
Age

#101

#102

#103

#105

#123

#106
#143

#113

#124

#121

#111 #116

#112 #117

#130

#104

#129#108 #110

#142 #118

#114 #115

#125

#122

All Species
Trees

Species

Trees

Calc'nNo Calc'n

<F2> 'O'

Vert.
Distance

#119

Live
Crown

#107

Age
Suppres’n

#120

Hot Keys 

F1 Sample or Tree Remarks F5 Display Incomplete (re)measurements -  
F2 Display Mapped Trees - from screen #111  from ID tree subsystem 
 Tree Class/Path-Tree Measurements - from others F6 Stem Map (#111 or #112 - from ID tree 
F3 Previous Measurements - re-measurement  subsystem) 
F4 Measure Tree - from screen #121, 124 F7/tab Picklist for Tree Species and Damage 
 Measure Height - from ID tree sub-system   Type, Agents and Severity 
 Measure Missed Tree Data – from screens #135-137 
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Screen #101 
Vers:2002  MAIN MENU 
1. Identify Sample 
2. Identify Plot 
3. Measure Trees 
4. Sub-Plot/Dot Cnt. 
5. Sample Trees 
6. Stem Map 
7. Verify Complete 

 

Screen Item Notes 

1.      Identify Sample 

2.     Identify Plot 

3.     Measure Trees 

4.     Sub-Plot/Dot Cnt. 

5.     Sample Trees 

6.     Stem Map 

7.  Verify Complete 

 

 

* * It is recommended that these screens be accessed and completed in the same order as they 
appear so that full advantage can be taken of the editing capabilities of the software.* *  

• The sample and plot must be identified before other measurements can be made 

• Use the 'up' and 'down' arrows to choose the desired screen and then <Enter> 

• ‘Verify Complete’ should only be used after all measurements have been done. 

User Notes: 
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Screen #102 
<F1>       ID SAMPLE 
Reg Cmp L Ins Sam Tp 
 73  16     0  8   G 
Csamp 
Dia@1.3:Y or 1.37:N 
BrkPnt:4.0  Dia/Ht:D 
L/S:N SPrg:N Stmps:N 
Screen OK (Y/N)?:Y 

 
 

 
Screen Item Meaning Default Valid Notes 

Reg Region No. - 1 - 88 Unique provincial numbers 
Cmp Compartment # - 1 - 206 Unique provincial numbers 
L Comp. Letter - b/ or A - Z Some coastal compartments have a letter 
Ins Installation - 1 - 99 - 
Sam Sample Number - 1 - 999 - 
Tp Sample Type - GIMPRST G(natural), I(intensive forestry), M(productivity), P(photo), 

R(experimental), S(temporary) or T(silviculturally treated) 
Prompts: "create Y/N at establishment" 
"N" - will close screen, return to screen #101 
"Y" - will create measurement  ‘0’ 
 

Csamp Company Sample - - Character or Alpha if applicable 
Dia 1.3 Diameter at 1.3 Y Y or N Allows DBH at 1.3 m to be entered for the whole sample 
or 1.37 Diameter at 1.37 N Y or N Allows DBH at 1.37 m to be entered for the whole sample 
BrkPnt -  - Break point between plot and subplot 

>0.3 for (I),  4.0 for all others  
Dia/Ht DBH or Height D D or H - 
L/S 
SPrg 
Stmps 
Screen OK(Y/N) 

Lean or Sweep 
Special Program 
Meas. Stumps? 

- 

N 
N 
N 
- 

Y or N 
Y or N 
Y or N 
Y or N 

For some samples.  Applies to whole sample 
Used for special projects only 
For some samples.  Applies to whole sample 
Y - saves and moves to next screen 
N - returns to Csamp 
 

<F1> with cursor on Reg, Comp, L, Ins, Sam, Tp, lists all samples in the machine. 

User Notes: 
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Screen #103 
<F13>        ID MEAS 
Measurement      : 0 
Meas.Date:2001.08.24 
Estb.Date: 
StemMap:N SlctLogd:N 
THSS:C       SIBEC:N 
DBHRf:UpH SuitReMs:Y 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Default Valid Notes 

<F13> Hot Keys - Anytime F1 - Accesses area for sample remarks 

    F3 - At remeas., displays prev. measurement 

Measurement 

Meas. Date 

Estb. Date 

StemMap  

Slct Logd 

THSS 

SIBEC 

DBHRf 

SuitReMs 

Screen OK(Y/N) 

Meas. No 

- 

- 

- 

- 

TopHt Sectr 

- 

- 

Suitable 

- 

- 

- 

- 

N 

N 

C 

N 

- 

Y 

Y 

- 

- 

- 

Y or N 

Y or N 

C or A 

Y or N 

- 

Y or N 

Y or N 

Entered automatically. 

Automatic for establishment, update at remeasurement. 

Automatic for establishment, given for remeasurement 

If "Y" all trees must be stem mapped 

Y - for selectively logged areas in complex stands 

Top Height from (C)enter sector or (A)ll sectors 

Is this a SIBEC sample? 

Automatically. PoG for samples<1991 or UpH if >1990 

Is sample suitable for remeasurement or badly damaged? 

Y - saves and moves to next screen 

N - returns cursor to top of screen 

 

User Notes: 
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Screen #104 
<F13>    STND STRUCT 
Stand Structure    1 
 
C.Clsr% :Lyr1     50 
        :LyrV      2 
StHa:    0 SpSt: 0.0 
Spacing Type       S 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Default Valid Notes 

<F13> Hot Keys - Anytime F1 - Accesses area for sample remarks 

    F3 – Only at remeas. - displays prev. measurement 

Stand Struct. - - 1,2 or 3 Stnd. Struct. 1-simple, 2-complex, 3-multi-layer 

If ‘3’, each tree is in layer 1 or 2. Identify  primary layer. 

If ‘1’ or ‘2’, there is  a "V" layer and  layer 1 is assumed . 

C.Clsr%:Lyr1 

            :LyrV 

StHa 

SpSt 

Spacing Type 

Screen OK(Y/N) 

Crown Closure 

CC      layer V 

Stems/Hectare 

Special Site 

- 

- 

0 

0 

0 

0.0 

S 

Y 

10 - 100 

0 - 5 

1 – 99999 

0.0 or 5-50 

S or T 

Y - N 

CC for layer 1 in increment of 10's 

Vet layer must have a crown closure of <6% 

For (S) samples in young stands 

For use if age and height of sample are not representative 

Normally (S)quare but can be (T)riangular 

Y - saves and moves to next screen 

N - returns cursor to top of screen 

 

User Notes: 



Chapter 4:  GyHost - The Host PC System 15 

Screen #105 
<F1>         ID PLOT 
Plot#  1 CtrStk OK?Y 
Plot Radius    11.28 
     Area     0.0400 
Ln   0.00 Wth   0.00 
     BA Factr  0.000 
T/L Br   0 Dst   0.0 
 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Default Valid Notes 
<F1> Hot Key -   Anytime F1 - Accesses area for sample remarks 
Plot # No. of plot 1 1 - 10 1-10 or 1-5 for (I) samples, 1 or 1-3 (est. 80-88) for (G,T)  

Prompt  'Create (Y/N)' 
     "Y" - will create Meas. '0' 
     "N" - will close screen, return to screen #101 

CtrStk OK? 
Plot Radius 
           Area 
Ln 
Wth 
BA Factor 
T/L Br 
Dst 
Screen OK(Y/N) 

Centre Stake OK 
- 
- 
Length 
Width 
Basal Area Factor 
Tie Line Bear. 
T/L Distance 
- 

Y 
- 
- 

0.0 
0.0 
- 

b/  
b/  
Y 

Y - N 
5.0 - 30.9 
- 
- 
- 
- 
0-360 
0.1-999.9 
Y or N 

"N" if repairs made to plot center stake at remeas. 
- 
Automatically done if circular, enter if square 
Enter if missing  (R samples only) 
Enter if missing  (R samples only) 
For prism (S) samples 
- 
- 
Y - saves and moves to next screen 
N - returns cursor to top of screen  

     

User Notes: 
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Screen #106 
<F1234567>TREE Pl# 1 
Tree  79 D?N Spc: FD 
 Cs:   Ts: 1  Ss: 2 
D13: 15.7  D137: 0.0 
CC:2 LC%: 3 TC:2 Lr  
Ht: 0.0 St:N NxT   0 
Ms/Dp/F:  NrTre:   0 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Default Valid Notes 
<F123456 Hot Keys - Anytime F1  - Accesses area for tree remarks 

F2  - Recalls trees out of sequence 
- enter tree number, <enter> choose option 
- tree class/path or tree measurements 

F3  - Remeas. - displays previous meas. data 
F4  - Accesses screen 114 to measure heights 
F5  - List of trees incompletely measured 
F6  - Accesses stem map screen 
F7 – Picklist for tree species 

Tree Tree Number - - Entered automatically; change if out of sequence 
D? Delete tree? N Y or N Accessed by arrowing back 

Y - deletes tree at establishment or ingrowth at remeas. 
Spc 
Cs 
Ts 
Ss 

Species 
Center Sector 
Tagging sector 
Site sector 

- 
- 
- 
 

- 
C or b/  
1 - 16 
1 - 16 

See Appendix 3 for species symbols 
Enter C if largest DBH in center sector. If a SIBEC sample, 
enter a C for the largest DBH of every species. 
Will remain the same until changed at establishment 
Will remain the same until changed at establishment/remeas. 

D13: DBH at 1.3m - - Accessed only if chosen for sample in screen 102 
D1.37 DBH at 1.37m - - Accessed only if chosen for sample in screen 102 
CC Crown Class - 1-6 If TC5 entered, CC will revert to 5 and layer to V 
LC%: Live Crown % - 1-10 LC in 10’s  10=100 
TC: Tree Class - 1-6 TC 2, and 5 will access path screen; 3 and 4 dead tree screen 
Lr Stand  Layer b/  b/ , 1,2,V b/   assumes single layer 
Ht: Ht. (Est/Meas) 0.0 - Accessed for estimated veteran height or for small tree height 
St Stump N Y/N Accesses Screen 113 for stump measurements 
NxT: Next  Tree No. 0 >1 Appears automatically at remeasurement 
Ms/Dp/F Missed, dropped 

or fallen 
b/  

 
b/ ,M,D,F Missed trees at prev. meas. or dropped at remeas. Or a tree not 

found and assumed fallen and dead 
NrTre Near tree No. 0 >1 Used to identify location of ingrowth  or subplot trees 
ScreenOK(Y/N) - Y Y or N Y - saves and moves to next screen 

N - returns cursor to top of screen 

User Notes: 
To access stumps, Screen 102 must have a Y in stumps or Screen 103 must have a Y in selectively logged.  In Screen 106, leave 
diameter, CC, LC and TC blank.  Enter Y in ST for access to stump measurements in Screen 113. 
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Screen #107 
<F12>      Plot#: 1 
Ht Base LC Tree#  73 
Prv Ht to Lv Cr  0.0 
Ht to Live Crwn  6.5 
Bt LvCrwn%+50 Bt%- 2 
SlDist: 10.0 Sl%:  2 
Corr 1.30 Ht LC  6.5 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Notes 

<F12> 

 

Plot #:1 

Ht Base LC Tree # 

Prev Ht to Lv Cr 

Ht. to Live Crwn 

Hot Key 

 

Plot Number 

Tree Number 

Previous Ht to LC 

Height to live crown 

F1 - Accesses area for tree remarks 

F2 - Accesses screen for TC and Path 

Comes up automatically; check accuracy if more than one plot in sample 

Number of tree being measured for height to live crown 

Previous height to live crown, if available - at remeasurement only 

Enter height to live crown directly; or will calculate when all information is 
entered.  To redo, clear Ht to live crown 

Bt LvCrwn%+ Bot LC reading % Bottom of Live Crown reading in per cent 

Bot%- Bottom reading % Bottom reading in %.  Minus (-) is the default; change to plus (+) if desired 

SlDist: Slope Distance Slope distance in meters to one decimal place 

Sl%: Slope % Assumed equal to bottom reading; change if not 

Corr Correction Assumed 1.3 meters; change if not 

Ht LC Height to Live Crwn Calculated height to live crown comes up automatically.  To redo measurements, 

cursor to the top of screen and zero the Ht. to Live Crown 

Screen OK (Y/N)? Accept screen? Y - saves and moves to next screen 

N - returns cursor to top of screen 

 

User Notes: 
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Screen #108 
<F123456 PATH:Tr 109 
Fk/Ck   0 Scar     0 
FrostC  0 DeadTop  0 
BrknTop 0 BrkHt: 0.0 
Conk    0 Misltoe  0 
B.Conk  0 Rot Br   0 
Sweep     Lean     
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Default Valid Notes 
<F123456 Hot Key  Anytime F1 - Accesses area for tree remarks 

F2 - Recalls tree number out of sequence 
     - enter tree number <enter> and choose option 
     - tree class/path or tree measurements 
F3 - Remeas. - displays previous meas. data  
F4 - Accesses screen 114 to measure heights 
F5 - Lists trees incompletely measured 
F6 - Accesses stem map screen 
 

Fk/Ck 
Scar 
Frost C 
DeadTop 
BrknTop 
Brk Ht 
Conk 
Mistletoe 
B.Conk 
Rot Br. 
Sweep 
Lean 

Fork/Crook 
- 
Frost Crack 
Dead Top 
Broken Top 
Ht to Break 
- 
- 
Blind Conk 
Rotten Branch 
- 
- 

0 
0 
0 
0 
0 

0.0 
0 
0 
0 
0 

b/  
b/  

0 - 7 
0 - 7 
0 - 7 
0 - 3 

Y or N 
0.1 - 99.9 

0 - 7 
0 - 7 
0 - 7 
0 - 7 

 
 

Must be > than previous at remeasurement 
Must be > than previous at remeasurement 
Must be > than previous at remeasurement 
 
If Y, must have height to break. 
Accessed only if BrknTop is “1, 2 or 3’ 
Must be > than previous at remeasurement 
Must be > than previous at remeasurement 
Must be > than previous at remeasurement 
Must be > than previous at remeasurement 
Accessed only if ‘Y’ is entered in screen #102 
As above 

Screen OK(Y/N)  Y Y or N Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #110 
<F1234567>DMG AGENTS 
Tree#  109  Tag OK:Y 
InPlot:Y Dam?(Y/N):Y 
1Tp:D Agnt:SG Sv:  1 
2Tp:  Agnt:   Sv: 
PrvHt *   Ht Suit?:Y 
Nat/Plt:  NxTree 110 
Screen OK (Y/N)?:Y 

 

 
Screen Item Meaning Default Valid Notes 

<F123456 Hot Key - Anytime F1 - Accesses area for tree remarks 
F2 - Recalls tree number out of sequence 
     - enter tree number <enter> and choose option 
     - tree class/path or tree measurements 
F3 - Remeas. - displays previous meas. data 
F4 - Accesses screen 114 to measure heights 
F5 - Lists trees incompletely measured 
F6 - Accesses stem map screen 
F7 – When damage is ‘Y’, picklist for damage agents 
 

Tree # 
Tag OK 
InPlot: 
Dam? (Y/N) 
1Tp: 
Agnt: 
Sv: 
2Tp: 
Agnt: 
Sv: 
PrvHt: * 
Ht Suit? 
Nat/Plt: 
NxTr# 
 

Tree Number 
Is tree tag okay 
Tree inside plot 
- 
1stDamage type 
Agent 
Severity 
2ndDamagetype 
Agent 
Severity 
Previous Ht? 
Suitable for Ht? 
Natural/Planted 
Next Tree No. 
 

- 
Y 

Y 
N 
b/  
b/  

b/  
b/  
b/  

b/  
 

b/  
N 
 

1 - 9999 
Y or N 
Y or N 
Y or N 

- 
- 
- 
 
 
 
 

Y,N,C,V,E,F 
N or P 

>0 
 

Must be > 1 
N - if nail was missing (tag missing for ‘M’ samples) 
N - for trees measured outside plot. ie for ages 
(Y)es or (N)o 
If No, cursor will skip balance of screen 
See codes in Appendix 14 or use F7 
See codes in Appendix 14, <ENTER> or use F7 
If No, cursor will skip balance of screen 
 
 
The * indicates that a previous height was taken 
Yes, No, Could be, Very difficult, Easy, Flagged 
P for ‘T’ samples only 
Automatically at remeas.,  sequence at establish. 
 

Screen OK(Y/N)  Y Y or N Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #111 
<F12> 
STEM MAP, PLOT:    1 
Offset?            N 
Tree #           101 
Bearing from PC   20 
Slope%             0 
Slope Dist      0.80 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Default Valid Notes 

<F12> Hot Key  Anytime F1 - Accesses area for sample remarks 

F2 - Lists trees not stem mapped if StemMap is Y in 103 

       Lists trees stem mapped if StemMap:N in Screen 
103 

Plot: 1 

Offset? 

Tree # 

Bearing from PC 

Slope% 

Slope Dist 

Screen OK(Y/N) ? 

 

- 

Offset center 

- 

- 

- 

- 

 

1 

- 

- 

- 

- 

- 

Y 

1 - 10 

Y or N 

> 1 

1 - 360 

> 0 

- 

Y or N 

At remeas. 1-5, 1-10 for I, 1-3 for G & T otherwise '1' 

Read only. Determined by information on screen #123 

Must be >1 

360 is North 

- 

Cannot exceed the plot radius 

Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #112 
<F1> 
STEM MAP: PRODUCTVTY 
Tree #             1 
To Tree# Distance(M) 
1    5          0.95 
2    4          1.10 
3   22          0.30 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Notes 

<F1> 

Tree # 

To Tree # 

Distance 

Screen OK 

 

Hot Key 

Tree Number 

To Tree Number 

- 

- 

F1 - Accesses area for tree remarks 

Number of tree that is being stem mapped 

Number of tree to which the new tree is being mapped to 

Distance between the two trees (center to center) 

Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #113 
<F1256       STUMP 
Tree #             1 
Diameter cm     12.5 
Height    m      0.3 
New/Old   N/O      O 
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Default Valid Notes 

<F1256 Hot Keys - Anytime F1 - Accesses area for tree remarks 
F2 - Recalls tree numbers out of sequence 
      - enter number and choose option 
      - tree class or tree measurement 
F5 - List of trees incompletely measured  
F6 - Accesses stem map screen 

Tree # 

Diameter cm 

Height m 

New/Old 

No. of Stump  

- 

- 

- 

- 

0.0 

0.0 

b/  

900 - 979 

7.4-125cm 

- 

N or O 

Use only numbers.900 to 979 

Diameter of stumps of merchantable species only 

Height of stump 

(N)ew <10 years: (O)ld >10 years 

User Notes: 



Chapter 4:  GyHost - The Host PC System 23 

Screen #114 
<F12>      Plot#: 1 
InPlt Y Ht Tree# 103 
PrvHt       Ht  25.3 
Top%+  75   Bot%-  5 
SlDist 30.0 Sl%    5 
Ht Corr 1.30 Ht 25.3 
VertDist N MeasLC? N 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Notes 

<F12> 

Plot #:1 

Ht Tree # 

Prev Ht 

Ht. 

Top%+ 

Bot%- 

SlDist: 

Sl%: 

Ht Corr 

Ht 

Hot Key 

Plot Number 

Tree Number 

Previous Height 

Height 

Top reading % 

Bottom % 

Slope Distance 

Slope % 

Ht Correction 

Total Height 

F1 - Accesses area for tree remarks 
F2 - Accesses screen for TC and Path 

Comes up automatically; check accuracy if more than one plot in sample 

Number of tree being measured for height 

Previous height if available - at remeasurement only 

Enter height directly; or will calculate when all information is entered.  To redo 
height, clear Ht. 

Top reading in per cent 

Bottom reading in per cent.  Minus (-) is the default; change to plus(+) if desired 

Slope distance in meters to one decimal place 

Assumed equal to bottom reading; change if not 

Assumed 1.3 meters; change if not 

Calculated height comes up automatically.  To redo height measurements, cursor to 
the top of screen and zero the Ht. 

VertDist 

MeasLC? 

Screen OK (Y/N)? 

Vert Dist wanted 

Measure Live 
Crown? 

Accept screen? 

Default is N. Change to Y if vertical distance is required (Screen #119). 

Default is ‘N’. Change to ‘Y’ if measured live crown is required (Screen #107). 

Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 

If number of tree entered does not exist in sample, the cursor will not proceed. 
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Screen #115 
<F12>   Pl  1 Tr 103 
AgeCore Taken(Y/N):N 
PrvBHAge:  0 Age: 40 
 New Age:  0 Pith?:Y 
Bor Ht:1.30  Ri5:  9 
Ri10:  9    Ri20: 15 
In Plot?Y Supprs’d:N 
Screen OK (Y/N)?:Y 

 

 

Screen Item Default Notes 

<F12> 

 

Pl 

Tr 

AgeCore Taken 

PrvBHAge 

Age 

New Age 

Pith?: 

Bor Ht: 

Ri5: 

Ri10: 

Ri20: 

In Plot? 

Supprs’d: 

 

 

Current plot no. 

Tree number 

N 

Previous BH age 

- 

- 

b/  
1.30 m 

0 

0 

0 

Y 

N 

F1 - Accesses area for tree remarks 

F2 - Accesses TC and Path screen 

Plot number that tree is in: change as required 

Tree number selected for age measurement: change as required 

<Y or N> If core taken <Y>, age need not be entered at this time 

At remeasurement, previous breast height age if applicable 

Current BH age 

New age at remeasurement 

Was pith hit? Y(es), N(o) or R(otten) or E(stimate) 

Should be and is assumed to be 1.3 m: change if not 

Length of last 5 years in mm 

Length of last 10 years in mm 

Length of last 20 years in mm 

Is tree inside plot 

Sign of suppression in the age core; (Y)es, (N)o, (P)ossibly Y or P will access Screen #120 

Screen OK (Y/N)? Y Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 

Re-entering (changing) the “New Age” will delete all the data associated with it – 
Pith, Ri5, Ri10, Ri20, and Supprs’d. 
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Screen #116 
         SAMPLE TREE 
1 ID Sample Trees 
2 ID SmpTrees-NoCalc 
3 Measure Height 
4 Measure Age 
 
Choose and <Enter> 

 

 

Screen Item Notes 

1. ID Sample Trees Calculates species composition and systematically allows for selection and measurement of sample 
trees. 

2. ID SmpTrees-NoCalc -  Same as above but does not calculate/recalculate species composition. 

- - - -    Use only if no changes have been made to the data  since last calculated  - - - - 

3. Measure Height Accesses screen #114 for height measurements 

4. Measure Age Accesses screen #115 for age measurements 

 

• Use the 'up' and 'down' arrows to choose the desired screen and 
<Enter> 

User Notes: 
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Screen #117 
SAMPLE COMPOSITION 
L SP  BA%    NT  ST 
  FD   53.3  12  11 
  CW   33.4   9   5 
  HW   12.8   3   1 
  DR    0.4   1   0 
Layer , Den:  13.52 
F2=Selected; O=Order 

 

 

Screen Item Meaning Notes 

L 

 

SP 

BA% 

NT 

ST 

QMD 

Layer 

 

Species 

Basal Area % 

Number of Live Trees 

Number of Suitable Trees 

Quadratic Mean Diameter 

 

- If single layer, will appear blank 
- If Vet layer, will display a 'V' 
- If double layer, will display '1' or '2' 

 

Per cent basal area of the species for the layer 

Total number of living trees for the species indicated 

Number of suitable height trees for the species 

Accessed by moving the cursor to the right of the screen 

Note: To take full advantage of the software, it is recommended that the following procedure be used and 
only after all trees have been measured. 

Arrow up ( ) or down ( ) to access other species or layer. 

1. < F2 > To access screen #142 which lists all sample trees chosen for height 
measurement. 

2. < O > To access screen #118 to view and choose trees for height measurement. These 
will be listed by species and in descending order of DBH. For the first two 
major species, site height trees will be identified with a ‘S’ or ‘N’ if not 
suitable for height.  The top height tree for the sample will be identified with a 
“T”  If the top height tree is also a site height tree, it will appear as a ‘B’ 

Return to screen #117 by < esc > once back 

Repeat step '2'  for each species present 

User Notes: 
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Screen #118 
 ALL SAMPLE TREES:FD 
?S P Tree Ss DBH  HA 
HS 1  109  6 35.7 * 
NS 1  111  8 33.4   
M  1  103  2 32.1 ** 
O  1   10  7 31.2   
THt:  SHt: 2 OHt: 5 
H,A,R,O,P,F2,Esc 

  ALL SAMPLE TREES:FD 
?S P Tree TC CC In S 
HS 1  109  1  2  Y Y 
NS 1  111  1  2  Y N 
M 32. 103  2  2  Y E 
O 31.  10  1  3  Y F 
THt:  SHt: 2 OHt: 5 
H,A,R,O,P,F2,Esc 

 

Screen Item Meaning Notes 
? 
 

Status previously assigned 
 

- (Y)es,(N)o,(C)ould be (V)ery difficult, (E)asy and (F)lagged 
- (T)opHt, (S)ite Tree, (B)oth topHt and site tree,  (O)ther.  Changes to H, D, L, 
or M when measured.  X means the tree was rejected for ht measurement. 

S 
P 
Tree 
Ss 
DBH 
H 
A 

SIBEC tree 
Plot Number 
Tree Number 
Site Sector Number 
DBH 
Measured height 
DBH age taken 

If SIBEC field in screen #103 was ‘Y’.  S if suitable, N if not 
- 
- 
- 
- 
At remeasurement, an '*' will appear if the height was previously taken 
At remeasurement, an ‘*’ will appear if the DBH age was previously taken 

 
TC 
CC 
In 
S 
 

 
Tree Class 
Crown Class 
Inside/outside plot 
Original tree height suitability 

The following will also appear by cursoring to the right 
- Will appear as 1,2, or 5 for Vets 
-Will appear as 1,2,3,4, or 5 for Vets 
- Tree was entered as being inside or outside plot 
-  Yes, No, Could be, Easy, Very difficult or Flagged 
 

THt 
SHt 
OH: 

Top Height tree 
Site Height trees 
Other Heights 

- Number of 'top height' trees (automatically chosen by the program) 
- Number of ‘site height’ trees (automatically chosen by the program) 
- Number of 'other height' trees selected by user for height measurement 
 

H 
A 
R 
O 
P 
F2 
 
Esc 

Height 
Age 
Reject 
Other Height 
Path 
Hot Key 
 
Escape 

-Select tree for height measurement 
-Select tree for age measurement 
- Reject tree for height measurement 
- Chosen as 'other height' 
- Accesses path screens 
- Toggles between  Selected Trees and available trees  for measurement 
 
Escapes to Screen  #117 - Sample Composition 
 

User Notes: 
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Screen #119 
<F12>      Plot#: 1 
Tr# 103 Vrt Dst 25.3 
Top%+  75   Bot%-  5 
SlDist 30.0 Sl%    5 
Cor 1.30 VrtDst 25.3 
Bearing of Lean:  10 
DistPog 12.0 Sl%-  5 
Screen OK (Y/N)?:Y 

 

 

Screen Item Meaning Notes 

<F12> 

Plot #:1 

Tr# 

Vrt Dst 

Top%+ 

Bot%- 

SlDist: 

Sl%: 

Cor 

Vrt Dst 

Bearing of Lean 

DistPog 

Sl% 

Hot Key 

Plot Number 

Tree Number 

Vertical Distance 

Top reading % 

Bottom % 

Slope Distance 

Slope % 

Correction 

Vertical Distance 

Bearing of Lean 

- 

Slope % 

F1 - Accesses area for tree remarks 
F2 - Accesses screen for TC and Path 

Comes up automatically; check accuracy if more than one plot in sample 

Number of tree being measured 

Enter vertical distance directly or will calculate when all information is entered 

Top reading in per cent 

Bottom reading in per cent.  Minus (-) is the default; change to plus(+) if desired 

Slope distance in meters to one decimal place 

Assumed equal to bottom reading; change if not 

Assumed 1.3 meters; change if not 

Calculated vertical distance comes up automatically.  To redo measurements, cursor 
to the top of screen and zero the Vrt Dst. 

Bearing of Lean 

Distance to point of germination in meters to one decimal place 

Slope per cent 

Screen OK (Y/N)? Accept screen? Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #120 
<F12>   Pl 1 Tr    5 
        BH Age  : 75 
Core Length     :107 
Suppressed Age  : 35 
Suppressed Lngth: 39 
Suppressed 10yrs: 11 
Released 10 yrs : 22 
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Valid Notes 

<F12> 

 

Pl 

Tr 

BH Age / New Age 

Core Length 

Suppressed Age 

Suppressed Lngth 

Suppressed 10yrs 

Released 10yrs 

Screen OK (Y/N) 

Hot Keys 

 

Plot Number 

Tree Number 

Breast Height Age 

Core Length in mm 

- 

Suppressed Length mm 

Length of 10yrs of 
suppression 

Length of 10yrs of release 

 

Any Time 

 

- 

- 

 

1 - 999 

1 - 500 

1 - 999 

1 - 200 

1 - 200 

Y or N 

F1 - Accesses area for tree remarks 

F2 - Accesses screen for TC and Path 

Same as plot number in screen from which it came 

Same as tree number in screen from which it came 

Transferred from previous screen. BH Age at 
establishment, New Age at remeasurement. 

 

 

 

 

Must be two times the suppressed length 

Y - returns to the Age screen #115 

N -  returns cursor to top of screen 

 

User Notes: 
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Screen #121 
<F4>       DOT COUNT 
Spc    D-0    D-1  
FD       2      3  
CW       1      2  
                    
Blank Spc. to Delete 
Esc when Done 

 

 

Screen Item Meaning Default Valid Notes 

<F4> 

Spc 

D-0 

D-1 

Hot Key 

Species 

DBH class '0' 

DBH class '1' 

- 

   b/  

0 

0 

Anytime 

- 

- 

- 

F4 - Accesses tree measurements (screen 106) 

See Appendix 3 for species symbols 

0.30 - 1.3 metres in height 

0.1 to 1.9cm in DBH 

 

D-2 to D-10 

D-11 

 

DBH classes 

DBH class 

 

0 

0 

 

- 

- 

For Intensive Forestry Samples Only 

In 2.0cm classes (2.0-3.9, 4.0-5.9,etc) 

All trees greater than 20.0cm in DBH 

 

User Notes: 
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Screen #122 
-PRODUCTIVITY SCAR-- 
         TREE#     1 
Base     0 
Mid      0 
Top      0 
Screen OK(Y/N)?: Y 

 

 

 

Screen Item Meaning Default Valid Notes 

Tree # 

Base 

Mid 

Top 

Screen OK(Y/N) 

 

Tree No. 

- 

- 

- 

- 

 

0 

0 

0 

Y 

1 - 1000 

0 - 8 

0 - 8 

0 - 8 

Y or N 

- 

Base is from germination point to 1.3m 

Mid is from 1.3m to the mid point on the tree 

Top from the mid point on the tree to the top 

Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 
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Screen #123 
<F1>      DATA:Pl# 1 
Aspect 180 Slope% 10 
Elev  400  Sl Pos  M 
PlotCentre OFFSET? N 
Bearing to PC      0 
Slope %            0 
Slope Distance  0.00 
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Default Valid Notes 

<F1> 

Aspect 

Slope % 

Elev 

Sl Pos. 

 

Hot Key 

- 

- 

Elevation 

Slope Position 

 

- 

0 

0 

- 

- 

 

Anytime 

0-360 

0 - +100 

1 - 2500m 

- 

 

Accesses area for sample remarks 

If slope is >0, then aspect must also be >0 

If aspect is >0, then slope must also be >0 

Elevation in meters 

Valid codes are C,D,F,L,M,T and U 

- C(rest), D(epression), F(lat), L(ower), 

- M(id-slope), T(oe), and U(pper-slope) 

Stem Offset? 

 

Bearing to PC 

Slope % 

Slope Dist 

Screen OK(Y/N) 

- 

 

- 

- 

Distance in ‘m” 

N 

 

0 

0 

0.00 

Y 

Y or N 

 

1 - 360 

-100 - 100 

1 - 9 

Y or N 

Accessed only if screen #103 had Y for stem map. 

If Y, bearing and slope distance must be >0 

Bearing from compass location to plot center 

Slope from compass to plot center 

Slope distance from compass location to plot center 

Y - saves and moves to next screen 
N - returns cursor to top of screen 
 

User Notes: 

At remeasurement, Aspect, Slope%, Elevation and Slope Position fields are only accessible if previously blank.  

Once entered and the screen is accepted, changes cannot be made. 
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Screen #124 
<F14>   SbPlot/DtC 1 
Sub-Plot Rad.   5.64 
        Area  0.0100 
     BA Factr  0.000 
 
 
 
Screen OK (Y/N)?:Y 

<F1>    SbPlot/DtC 1 
Sub-Plot Rad.   5.64 
        Area  0.0100 
+-S-Plot/Dot Count-+ 
|Meas S-Plot Trees | 
|Do Dot Count      | 
+------------------+ 
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Default Valid Notes 

<F14> Hot Keys - Anytime F1 - Accesses area for sample remarks 
F4 - Accesses area for tree measurement 

Sb-Plot/DtC 

Sub-plot Rad. 

SubPlot No. 

Sub-Plot Radius 

1 

None 

 

1-10 

- 

-Entered for establishment 

-Present at remeasurement otherwise must be entered 

-Area will come up automatically 

-Enter BA Factor  for ‘S’ samples only  

 

[for (I) samples an ingrowth radius comes up and 
must be entered] 

Screen OK(Y/N)  Y Y or N Y - saves and prompts: - S-Plot/Dot Count box  

                   Toggle for: - Meas S-Plot trees 

                                       or 

                                       Do Dot Count 

N - returns to top of screen 

 

User Notes: 
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Screen #125 
<F137>    Dmg Agents 
Compl/Partl/Blank  P 
BDstrb:N  Dist:  0.0 
Type1:I    Type2:    
DmAgt1:AB  DmAgt2:   
DSev1: 15  DSev2:    
Yr1:   0   Yr2:   0  
Screen OK (Y/N)?:Y 
 

 

 

Screen Item Meaning Default Valid Notes 

<F137> 

 

Hot Key - 

 

As 
available 

 

 

F1 - Accesses area for plot remarks 

F3 – Only at remeas.- displays previous meas. data 

F7 – For pop-up screens for Types and Agents. 

Compl/Partl/Blank - - C,P or b/  (C)omplete, (P)artial, or ( b/ )no damage 

BDstrb: 

Dist: 

Type1 

DmAgt1 

DSev1 

Buffer Dist  

Distance 

1st type of damage 

1st damage agent 

Severity of 1st agent 

N 

0.0 

 

 

 

Y or N 

- 

Various 

Various 

1 - 100 

Has the buffer been disturbed? 

Distance from plot circumference to disturbance 

See appendix 14 or press F7 

See appendix 14 or press F7 

Calculated percentage of damage to sample 

Yr1 Yr damage occurred 0 0 or year Enter year if known 

Type2 2nd type of damage   Various See appendix 14 or press F7 

DmAgt2 2nd damage agent  Various See appendix 14 or press F7 

DSev2 Severity of 2nd agent  1 – 100 Calculated percentage of damage to sample  

Yr2 Yr damage occurred 0 0 or Year Enter year  if known 

Screen OK (Y/N)  Y Y or N Y - saves and moves to next screen 
N - returns cursor to top of screen 

User Notes: 
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Screen #129 
<F12456>   Dead Tree 
Tree#   4 CertCode 1 
Spc  FD   CertCode 1 
Vertical Position  S 
Brk Top? Y BrHt  5.0 
WldLfeAp 2 DownPos  
DeadTree Stmp(Y/N) N 
Screen OK (Y/N)?:Y 

 

Screen Item Meaning Default Valid Notes 

Tree# 

CertCode 

Spc 

CertCode 

Vertical Position 

Brk Top? 

BrHt 

WldLfeAp 

Down Pos 

 

DeadTree Stmp 

Screen OK (Y/N) 

Tree Number 

No. Certainty Code 

Species 

Spc. Certainty Code 

Vertical Position 

Broken Top Y/N 

Height to Break 

WildLife Appearance 

Down Position 

 

Dead Tree Stump? 

- 

0 

- 

0 

- 

N 

0.0 

0 

- 

 

N 

Y 

- 

1 - 3 

- 

1 - 3 

S or D 

Y or N 

 

1 - 9 

S or G 

 

Y or N 

Y or N 

Same as tree number in screen from which it came 

See Appendix 22 

Same as tree species in screen from which it came 

See Appendix 22 

See Appendix 22; S only for establishment 

 

Accessed only if Brk Top is ‘Y’ 

See Appendix 22 

(S)uspended or on the (G)round.  Only accessible if 

Vertical position is ‘D’ 

- Is the stump that of a dead tree? 

Y - returns to Near Tree No. in screen 106 

N - Returns cursor to top of screen 

User Notes: 
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Screen #130 
  Verify Complete 
1.Trees Stem Mapd? 
2.Damage Agents? 
3.Sample Trees 
4.Trees in Sample? 
5.All Trees Measd? 
6.All Hghts Taken 
7.All AgeCores Tkn? 
8.Crown Cls BrkDwn 

 

Screen Item Notes 

1.  Trees Stem Mapd? If the sample was stem mapped, will list trees not stem mapped.  Otherwise will give a warning if 
less than three trees are stem mapped. 

2.  Damage Agents? Checks that damage agents/severity information is entered for the sample, if at least one tree has 
information; or vice versa. 

3.  Sample Trees Summarizes the number of height and age trees taken by species and by type - top height, site  or 
other. 

4.  Trees in Sample? Summarizes the number of trees in the sample and sub-sample.  The latter will be further sub-
divided into dot count and others.  A warning is given if there are less than 110 trees. 

5.  All Trees Measd? Lists trees that have not been remeasured or have not been completely measured. 

6.  All Hghts Taken Lists trees chosen for height measurement that have not been measured. 

7.  All AgeCores Tkn Lists trees that do not have the age core entered as ‘Y’ or BHage entered. 

8.  Crown Cls BrkDwn Lists number of trees and their per cent of crown class by layer. 

 
• Use the ' ' and ' ' arrows to choose the desired screen and then <enter> 
• 'Verify Complete' should be used after all measurements have been made or after any changes to the data. 

User Notes: 
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Screen #142 

  ALL SELECTED TREES 
?SPl Tree Ts DBH  Sp 
HS 1  102  1 30.3 FD 
T  1  153  2 32.1 FD 
M  1  104  2 12.2 FD 
HN 1  115  3 29.8 FD 
M  1  109  4 20.2 FD 
H,A,R or EscTo Exit 

  All SELECTED TREES 
?SPl Tree H A TC Lyr 
HS 1  102 * *  1   
T  1  103      2   
M  1  104      2   
HN 1  105 *    1   
M  1  109 * *  1   
H,A,R or EscTo Exit 

  All SELECTED TREES 
?SPl Tree InPl SuitH 
HS 1  102   Y     Y 
T  1  103   Y     F 
M  1  104   Y     Y 
HN 1  105   Y     C 
M  1  109   N     Y 
H,A,R or EscTo Exit 

 

Screen Item Meaning Notes 

? Status S - assigned as site tree 

D - measured site tree 

T - assigned as 'top height' tree 

H - measured 'top height tree' 

B - assigned as both site and top height tree 

L - measured  site and top height tree 

O - selected as 'other tree height’ 

M - measured 'other tree height' 

N – Top height or site tree not suitable for height measurement 

S 

Pl 

Tree 

Ts 

DBH 

Sp 

SIBEC tree 

Plot Number 

Tree Number 

Tagging Sector Number 

- 

Species 

If SIBEC field in screen #103 was ‘Y’.  S if suitable, N if not 

Usually '1' but can be 1 - 10 for a multi plot sample 

In ascending order by plot 

- 

- diameter at breast height 

- 

 

H 

A 

TC 

Lyr 

In Pl 

SuitH 

H 

A 

 

Height 

Age 

Tree Class 

Layer 

Inside Plot ? 

Original height suitability 

Height 

Age 

The following will appear by cursoring to the right 

An '*' will appear if height was taken at a previous measurement 

An ‘*’ will appear if a DBH age was taken at a previous measurement 

- 

If single layer: blank or 'V': otherwise '1' or '2' 

Y – inside the  plot;  N – not inside the  plot 

Yes, No, Could be, Easy, Very difficult or Flagged 

Will access screen #114 for measuring tree heights 

Will access screen #115 for recording tree age 

R 

Esc 

Reject 

Escape 

Will remove tree from selected height tree status 

Closes screen and accesses screen #117 
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Screen #143 
  VERIFYFY SECTORS 
 
Plot#:  1 
Highest Tag Sect:  8 
Highest SiteSect:  4 
 
Screen OK (Y/N)? Y 

 

 

Screen Item Meaning Valid Notes 

Plot# 

Highest Tag Sect: 

Highest SiteSect: 

Screen OK (Y/N): 

Plot number 

Highest tagging sector used 

Highest site sector used 

Is information in screen OK 

1 - 10 

1 - 40 

1 - 40 

 

-  will show the plot number being worked on 

-  will list the highest tagging sector number used in the plot 

- will list the highest site sector number used in the plot 

N - will access tree screen #106 to correct sector numbers 

Y - will access the Main Menu    Screen #101 

 

User Notes: 
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Chapter 4: 
GyHost - The Host System 

Introduction  

GyHost is designed to be run in one of the following ways: 

- Under DOS in either Real or Protected mode. 

- In a Windows environment. 

Running in a DOS environment 

GyHost may be run in a DOS environment in either a Real Mode or Protected Mode.  If you 
have at least 2 MBytes of RAM, GyHost should be used whether or not you have the 
capability of running in protected mode.  The program will determine this and execute in the 
most appropriate way. 

Setting up GyHost and GyHand under Windows Operating System 

Introduction 
While both GyHost and GyHand are DOS programs, your Windows system may be 
configured to run them as you would run normal Windows programs. 
We will discuss the required setup procedures for Windows 98, Windows NT 4.0 and 
Windows XP. 
As a starting point, you should have the GyHost02 diskette which contains the complete 
zipped up GyHost / GyHand system or go to the TIB website to obtain the software. 
Create a suitably named directory, i.e. GyHost02 and unzip GyHost02.zip into it. 
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Setting up under Windows 98 

This procedure may also apply to Windows 95. 
1. Clone the MS-DOS Prompt shortcut to create another copy by Right-clicking on it and 

selecting ‘Copy’ then right clicking on the desk-top and clicking ‘Paste’ 
2. Change the title of the new copy to ‘GyHand02’ 
3. Right-click on this new shortcut and select properties. 
4. Choose the Program tab. 

5. In the ‘Cmd_Line:’ field, enter <path>\Gy.bat where <path> is the full path of the GyHost 
directory. 

6. In the ‘Working:’ field, enter <path> as above. 
7. Ensure the ‘Close on Exit’ box is checked. 
8. Apply the changes then press [OK]. 
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9. Repeat steps 1 through 8, this time cloning from the GyHand02 shortcut just created.  
Enter a name of GyHost02, and use ‘GyHost.bat’ instead of ‘Gy.bat’.  The <path> is the 
same as for GyHand. 

Setting up under Windows NT 4.0 

1. Copy the file CONFIG.GY0 from the GyHost directory into c:\winnt\system32\. 
2. Using Windows NT Explorer, highlight the Gy_Host.exe entry. 
3. Right-click and select properties. 
4. Select the ‘Programs’ tab and press the ‘Windows NT …’ button 
5. In the Windows NT PIF settings associated with the ‘Config filename’, change the 

contents to “%SystemRoot%\SYSTEM32\CONFIG.GY0” 
6. Follow the same procedure (steps 2 through 5) for the Gy_Hand.exe 

7. Select Start → Settings → Task Bar, select the Start Menu Programs Tab and then press 
the [Add] button. 

8. Browse for ‘GyHost.bat’ in your GyHost02 directory and select it. 
9. Press next and select the program group in which both GyHost and GyHand will be 

housed. 
10. Next enter the name which will appear on the sub-menu and press finish. 

 
11. Repeat steps 7 through 10 for Gy.bat. 
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12. Your Start → Programs will now contain an entry for the program group which, itself 
will have an entry for each of GyHost and Gy. 

Setting up under Windows XP 

Editing “Config.nt” file 

Although the same procedures can be followed as for Windows NT 4.0 the simplest method to set the number 
of files is as follows:  

1. Select [Start] → [Run]. 
2. Type [cmd] in the dialogue box, if it is not already in view. 
3. At the “C Prompt” [C:\>] type “edit c:\windows\system32\config.nt” and <enter>. 
4. Locate at the bottom of the screen the line where “files=200”.  Change it to “files=249” or some other odd 

number. 
5. Save the changes and exit. 

Creating Icons and Program Shortcuts under Start-up Menu 

To enter an Icon in the Desktop for GYHost do the following: 

1. Select [Start] → [Programs] → [Windows Explorer]. 
2. Find the directory where GyHost software resides. 
3. Right click the mouse on the file named GYHOST.BAT and <Copy>. 
4. Go up to the top of Windows Explorer and select Desktop. 
5. Right click the mouse and enter <Paste>. 
6. The icon for GYHOST.BAT will now appear on the Desktop. 
7. Repeat steps 1-5 for GYHAND.BAT. 
 
To enter a shortcut under Programs do the following: 

1. Select [Start] → [Programs] → [Windows Explorer]. 
2. Copy the file named GYHOST.BAT as above. 
3. Find C:\Documents and Settings\{User Name}\Start Menu\Programs. 
4. Right click the mouse to paste this file on the Programs Start Menu. 
5. Repeat these steps with GYHAND.BAT. 
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Starting GyHost 

With the current directory as GyHost, type:  GyHost<Enter> 

This will invoke the GyHost program and present the Main Menu to the user. 

Note: The first time that GyHost is invoked a message will come up regarding the use of 
printers.  Follow the instructions on the screen for printer and port set-up as well as 
skipping/retaining the message. 

Multi-tasking in Windows 

Running GyHost or GyHand will tie up a lot of the computer’s memory.  If other applications 
are running slower than desirable, the user can free up those resources by doing the 
following: 

At the “Command Prompt” in the GyHost directory type an “f” after GyHost or GyHand:  i.e.  
C:\>Gyhost02\gyhost f <Enter>or gyhand f <Enter>. 
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GyHost Screens 

Host Screen Structure Chart 
Version 2002  (02.06.01) 

#001

Display

Plots

Sample
Composition

Access
Notes

Plot
Detail

Dot
Count

Tree
Detail

Display Sel-
-ected Trees

Report
Menu

Housekeeping
Menu

Correct

Sample I.D.

Quality Assurance

Trees

Data Upload/
Download Menu

Download
Data

Upload
Data

#050

#062

#060 #066

#067

#061 #065

#070

#051

#054

#052

#053

#091 #092

#052

Main
Menu

Maintain
Samples

Verify
Complete

#080

DataTran
Menu

#093

Reports

#1 - #9

Datatran

#1 - #7
Modules

Matrix File

Extract

#040

Maintain

Valid'n Rules
#068
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Screen 1.  Maintain Samples 

<Enter> “1. Maintain Samples” and the following screen appears requesting sample 
identity.  By pressing <Tab> while the cursor is on Region, a list of samples in the Database 
appears.  Cursor to the desired sample and <Enter>. 
 

Once the sample identity is entered, the user can edit the sample header data by pressing: 
(E)dit 
or  
view (P)lot and (T)ree attributes or (D)ot count information 
or 
 (S)ample composition followed by viewing the (T)ree attributes as in above 
or 
enter or edit the (A)ccess Notes. 
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Screen 2.  Reports Menu 

<Enter> “2. Reports Menu” to view the data in one of the ten predetermined report formats.  
These reports are intended to aid in determining the quality of data collected.  Data cannot be 
edited in these reports. 
 

Having selected the Reports Menu from the Main Menu  the user is then given the option of 
selecting the (C)urrent or (P)revious Measurement, of one or more samples, one or more 
reports and destination as (P)rinter, (S)creen, or (F)ile. 

1. Access Notes Report - Describes the route to the permanent sample. 

2. Remeasurement Exception Report - This report displays the most important collected 
variables that were beyond the edit range.  Values outside this range are identified by an 
*.  The system checks for tagging sector, species, dbh, tree class, crown class, and height. 

3. Sample Header Detail Report - This report displays sample header data, and dot count 
information. 
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4. Comprehensive Tree Detail Report - This report displays all the tree data for each tree 
in the sample 

5. Key Tree Information Report - This report displays the key tree data for each tree in 
the sample plus a minor amount of header data.  This report may be used in the field as a 
hard copy. 

Glossary of Headings for Report # 5 

L 
Y Layer number 

S 
u Height suitability 

Ms 
No Measurement number 

Tree 
No Tree tag number 

Sector 
Cs 
Ts 
Ss 

Sectors 
Center sector 
Tagging sector 
Site sector 

Sp Tree species 
DBH 
1.3M Diameter at 1.3 meters 

Dia 
1.37M Diameter at 1.37 meters 

TC Tree class 
- Path – 
f 
s 
c 
d 
b 
c 
m 
b 
r 

Pathological indicators 
Fork 
Scar 
Frost crack 
Dead top 
Broken top (Ht to Brk shown under dead tree) 
Conk 
Mistletoe 
Blind conk 
Rotten branch 

C 
C Crown class 

LC% 
Est 
Msd 

Live crown as a per cent of the total tree height 
Estimated in 10’s 
Actual to 0.1m 

Ht Tree height in meters 
S 
t Status and type of the height 

  BH 
Age Breast height age 

S 
? Suppressed? 
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  Sw Sweep 
Ln Lean 
OP Outside plot 
DmAgt1 
Tag 
Sv 

Most damaging agent 
Type and agent codes. May be blank 
Severity 

DmAgt2 
Tag 
Sv 

Second most damaging agent 
Type and agent codes. May be blank 
Severity 

Near 
Tree Near tree number 

Miss 
Dr/F 

Missed at previous measurement 
Dropped at this measurement/not found; assumed fallen and dead 

 Dead Tree  
S/D 
Brk Top 
Ht Brk 
Wl Ap 
Cert T# 
Cert Sp 

 
Standing or down 
Broken top? 
Height to break 
Wild Life Appearance 
Tree number certainty code 
Species certainty code 

6. Tree Range, Ingrowth, Missed/Out of Plot Trees Report - This report displays the 
range of tree numbers used in the sample and should be used to avoid duplicating tree 
numbers.  It also displays ingrowth trees larger than 15 cm, trees suspected of being 
missed at previous measurement(s), trees to be dropped because they were found to be 
outside the plot boundary at remeasurement, and information on dead trees. 

7. Trees/Sample, Species Composition, Sample Tree Report - This report displays the 
number of trees (by species) in the sample and sub-sample with the diameter ranges.  It 
also displays the number of height sample trees taken and their range of diameters by 
species.  This report aids in determining if the correct number and correct range of trees 
were measured for height.  This report also displays the sample trees in detail. 

Glossary of Headings for Report #7 (Height Sample Trees) 

Pl Plot number 
Sp Species 
Tree Tree tag number 
S 
u Height suitability 

DBH Diameter at 1.3m 
Hght 
CurP 

Current height in meters. An * under the P indicates a height taken at 
previous measurement 

S 
T Status and type of height 

BHAge 
CurPS 

Current age. If previous measurement exists, it is incremented and has an 
* under the P. The letters under the S indicates suppression. 
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New 
Age Age taken at this measurement 

A 
C Age core taken? 

SI Site index 
C 
s If SIBEC plot, shows SIBEC trees as S or Not suitable 

T 
s Tagging sector number 

S 
s Site sector number 

- Path - Pathological indicators 
f Fork 
s Scar 
c Frost crack 
d Dead top 
b Broken top 
c Conk 
m Mistletoe 
  
HtB Height to break 
Ln Lean 
Sw Sweep 
OP Outside plot 
RadInc Radial increment in mm for: 
5 5 years 
10 10 years 
20 20 years 

8. Quality Assurance Information Report - This report displays randomly chosen trees 
for the purpose of field checks. 

9. Data Collection Platform Report - This report displays the number of trees and the 
platform (HH or PC) where the trees were last modified. 

10. All Reports (except Reports 4, 8, 9) - Select this option to print all reports of one 
sample or all reports of all samples in the database. 

Configuring a Network Printer 

Introduction 
GyHost02 permits users to print reports to one of two locally connected printers as well as a 
network connected printer. 
The Reports selection screen has a field in which the user can select to which of the attached 
printers the report(s) should be directed.  Local ports will only appear if they have a printer 
attached to them.  The network port will only appear if the appropriate port mapping is done 
before entering GyHost. 
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Mapping the Network Port: 

MS-DOS processes running under Windows 95/98 and NT 4.0 allow for up to 3 parallel (or 
printer) ports.  As a matter of convenience, GyHost assumes that ports LPT1 and LPT2 may 
have locally connected printers and LPT3 (referred to as ‘Net3’ in GyHost) may have a 
network-attached printer. 
The use of LPT1 and LPT2 needs no explanation except to say that only ports with ‘ready’ 
printers will be selectable. 
The use of Net3 will only be possible if the following mapping is done immediately before 
Gy_Host.exe is invoked.  A convenient place to insert the mapping command is in 
GyHost.bat – the batch file that invokes Gy_Host.exe. 
In GyHost.bat you will see the following lines: 

rem net use lpt3 \\<ServerID>\<PrinterName> 
gy_host %1, 199 
rem net use lpt3 /delete 

You will notice that the ‘net use …’ commands have been remarked out with the ‘rem ‘ 
prefix. 
The first ‘net use …’ is the enabling command, the second (appearing following the 
‘Gy_Host …’ line) is the disabling command. 
Alternatively, you can enhance your enabling ‘net use’ line to give it a limited lifetime.  In 
this case you will not need the ‘net use …/delete’ following the ‘Gy_Host …’ line. 
If you are connecting to a remote printer through a printer server, you will need to remove 
these ‘rem ‘ characters and replace the <Server ID> and the <Printer ID> with ID’s suitable 
for your print server. 
See the discussion on the following page.  If these steps do not reveal your remote printer 
ID’s, consult your network administrator. 

Under Windows 95/98: 
To determine the Server and Printer ID, do the following:- 

1. Select Start → Settings → Printers 

2. Right-click on your network printer and select → Properties. 
3. Choose the Details tab and note the contents of the ‘Print to the following port:’ box as 

shown below: 
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The Server ID is contained between the ‘\\’ and the single ‘\’, the Printer ID is contained after 
the single ‘\’. 
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Under Windows NT: 

1. Select Start → Settings → Printers 

2. Right-click on your network printer and select → Ports. 
3. Locate your network printer – it will be towards the end of the list and will be checked as shown below. 
4. Note the Server and Printer ID’s. 

 
You may need to make the ‘Port’ column wider to be able to see the whole Server and Printer 
ID.  You can do this by dragging the column separator following ‘Port’ to the right. 

Under Windows XP: 

1. Select Start → Settings → Printers and Faxes. 

2. Right-click on your network printer and select → Properties and Ports. 
3. Locate your network printer – it will be towards the end of the list and will be checked as shown below. 
4. Note the Server and Printer ID’s. 
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Printing Reports on Unsupported Printers 

Introduction: 
The GyHost system uses the R&R report writer to produce the reports included under the 
“Reports Menu” GyHost main menu selection 
The supported printers that you may select are as follows: 

1. HP DeskJet Plus/500 
2. Canon BJ-300/330 (IBM Mode) 
3. Epson EX, FX High-Speed Draft 
4. Centronix 351/352/353 
5. HP LaserJet (Original) 
6. IBM/Lexmark PPSII 2380/2381 
7. Custom Printer Configuration 
8. Print to File Configuration 

Option 8 should be used when producing reports to a file (to be discussed later). 

Note:  If you are using  a Universal Serial Bus (USB) connected printer, 
you must use Option 8 - Print to File Configuration. 

 
Options 1 through 6 above are for the indicated printers, but it is possible that one of these 
may match a printer not included in the list.  Option 1 has worked on several printers 
including the Lexmark Optra S1255. 
If the printer you are using does not appear in the above list, use option 7 – Custom Printer 
Configuration to access the R&R Configuration Manager as shown below. 
 

Select printer and <enter> 
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<esc> and <esc> again 
Cursor to Save and <enter> 
Cursor to Quit and <enter> 
Cursor to Exit and <enter>  This will take you back to the Reporting Sub-System screen. 

Printing Reports from GyHost using MS Word 

If none of the printer models listed above work with the connected printer, the reports may be 
printed using MS Word.  This process involves using GyHost to produce the reports to a file 
using Option 8 - Print to File Configuration, then using MS Word to open the reports, set up 
the page size and font and finally print them. 
In the Reports screen of GyHost, select the “Destination” as FILE, enter a “FileName” (you 
may leave this as “GYREPORT.TMP”) and ensure the “Printer Model” is Printer#8.  This 
will write the report to the file GYREPORT.TMP in the directory in which GyHost is 
installed. 
Before starting up MS Word, it is a good idea to shut down GyHost.  Under most Windows 
operating systems, the GyHost and GyHand programs monopolize CPU resources resulting in 
other Windows programs running much slower. 
Using MS Word, open the file “GYREPORT.TMP” in the appropriate directory. 
The pagination is incorrect – the page breaks do not line up with the report pages.  This can 
easily be resolved by doing the following: 
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Page Setup 

Choose File → Page Setup. 
Selecting the Margins tab, and set the values as follows: 

 
Also, select the Paper Size tab and ensure: the Paper Size is "Letter"; the Width is 8.5"; the 
Height is 11"; and, the Orientation is Portrait. 

Font Selection 

Choose Format → Style → Modify → Format → Font”. 
Selecting the Font tab, set the values as follows: 
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Selecting the Character Spacing tab, set the values as follows: 

Printing Reports: 

Pagination may be verified by selecting the browse by page option at the bottom of the 
vertical scroll bar and then pressing the ‘previous page’ and ‘next page’ double arrow up and 
down buttons.  You should see the report move from one page to the next retaining exactly 3 
blank line at the top of each page. 
If you do not see this, ensure that you do not have any lines wrapping to the next in one or 
more of the reports.  Report #5 is likely to be the biggest offender here – it has the most 
characters on a line.  If you do see line wrap, either decrease the left and/or right margins in 
the page setup or increase the character condensation to .4 or more in the Font Character 
Spacing screen. 
When the setup is correct, you may print the reports in the same way you normally print 
documents from MS Word. 
If you wish to retain the reports in this customized format, save them as a .DOC file. 
For those wishing to print Report 8 through MS Word, you will need a different Page Setup.  
Change the "Top" and "Bottom" to 1" and the "Orientation" to Landscape.  Notice the Top 
and Bottom margins are now 1”. For these reasons, Report 8 cannot be easily formatted in the 
same file as the other reports – it is easier to produce it to a separate file and use the format 
indicated above. 
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Screen 3.  Verify Complete 

<Enter> “3. Verify Complete”.  This option will allow the user to choose any or all of the 
eight Verify Complete Reports for one sample or all samples in the database with the 
destination to printer, file or screen. 

1. Trees Stem Mapped? - This report checks that either three living trees per plot were 
stem mapped (stem mapped to the centre stake) or all trees in the sample (if the stem map 
code is “Y” ). 

2. Damage Agents OK? - This report checks that if damage agents were recorded for one 
or more trees in the sample, that the header also contains damage agents data and vice 
versa. 

3. Sample Trees - This report lists the species composition and the number of site height 
trees and other trees measured for height and age as well as the top height tree. 

4. Trees in Sample? - This report provides a summary of the number of trees in the sample 
(i.e. plot, sub-plot, and dot count). 

5. All Trees Measured? - This report provides a list of trees not completely measured for 
the new measurement or at establishment. 

6. All Heights Taken? - This report provides a list of trees chosen for height measurement 
but not done. 

7. All Cores Taken? – This report checks that the top height tree and all site trees have an 
age or a ‘Y’ entered in the age core taken in Screen #115. 

8. Crown Class BreakDown – This report provides the break down in number of trees and 
per cent of crown classes by layer. 

9. All of the Above - This option allows the user to report on all of the verify complete 
reports for one sample or for all samples in the database. 
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Screen 4.  Housekeeping Menu 

<Enter> “4. Housekeeping Menu”  The housekeeping menu allows three types of functions: 

1. Correct Sample ID - This function allows the user to change (at establishment only) the 
Reg., Compt., Let., Inst., Sample number.  The sample type cannot be changed. 

2. Maintain Validity Checks - This function allows viewing or modification of the 
validation rules and warning messages.  Note that this function is only available to the 
Branch. 

3. Quality Assurance Trees - This function allows viewing and modification of number of 
trees used for quality assurance. 
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Screen 5.  P.C. - HandHeld Communication Menu 

<Enter> “5. PC <> HandHeld Communication Menu”.  This will give the user 
two options: 

• Download Sample Data to Hand Held 
• Upload Sample Data from Hand Held 

Download Sample Data to Handheld 

<Enter> “1. DownLoad Sample Data to HandHeld”. 

• Screen #91 will show all the samples that are present in Sample.dbf in the 
GyHost directory, one on each line.  If there are more than can fit in the 
window, they can be accessed with the cursor keys.  A warning message 
advises that, if the download process is completed, all the application files 
currently resident on the HandHeld computer will be overwritten.  It is 
therefore important to ensure that all previously entered data on the 
HandHeld computer that is to be retained is uploaded prior to this 
DownLoad operation. 

• Those samples that are required to be downloaded must now be identified.  
This is done by moving the cursor up and down the list of samples and 
changing the Extract(Y/N) value from 'N' to 'Y'.  It can be changed back to 
'N' during this operation if a mistake is made. 

• When all required samples have been selected, press <Esc>.   This will 
terminate the selection process. 

 

• The prompt 'Ok To Continue and Extract Selected Samples?(Y/N)' shows. 
Pressing 'Y' will continue the download process by extracting all the relevant 
records from the application databases for the selected samples.  Pressing 'N' 
will, prompt the command 'Choose HandHeld Device' menu. 
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• When the extract process is complete, the program asks 'OkTo Copy new 
version of HandHeld Program? (Y/N)'. <Y> should only be needed once at 
the beginning of the Field Season. 

• When GyHost has assembled all the data to download, it presents a menu 
asking the user to select a HandHeld Device - Ministry HandHeld or any 
other. 

Downloading to the Ministry HandHeld Computer 

• A set-up screen is presented to the user.  The instructions presented here 
should be followed. They start with ensuring that the HandHeld is physically 
connected from either COM1 or COM2 on the host PC to the left-hand 
connector on the Husky.  The user should follow the instructions given on 
the GyHost screen by entering the commands into the HandHeld.  Before 'Y' 
is pressed to signal the setup is complete, the user should see the 'HCOM' 
screen on the HandHeld showing the logo. 

• When 'Y' is pressed on GyHost, a selection box is presented.  This asks the 
user to confirm/change communication parameters.  Changing parameters 
should not normally be necessary after the initial setup.  If changes are 
required, pressing <Tab> will present a picklist from which a suitable value 
can be selected by cursoring to it and pressing <Enter>.  The initial value can 
be retained by escaping from this picklist.  When 'Y' is entered for 
'Save&Exit' the communication program takes over. 

The communications program shows the following on a fresh screen: 

Husky Command Line FileTransfer Utility Version1.05 
(c) Copyright Husky Computers Ltd. December 1992. 

• If a communications error occurred, a screen similar to that shown below will 
be displayed: 

 

If (R)etry is attempted, communications is retried.  If anything else is 
entered, the communications process is exited. 

• Text will show on the screen to show the user the progress of the 
transmission.  It will end with a report of the free disk space on the 
HandHeld PC drive C:. The message 
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'Review Communications and Continue' 
'(R)etry, or anything else to proceed' 

will show regardless as to whether communication was successful or not. If 
communication could not be established with the HandHeld or a 
communication error occurred,  press  'R' to retry communications.  If all is 
well press anything else. 

Downloading to Any Other HandHeld Computers 

Selecting this option causes GyHost to shell out to DOS with the current 
directory being HandHeld under the GyHost directory.  All the files to be 
transferred to the HandHeld computer are contained in this directory. 

Using whatever software is supplied with the particular HandHeld computer, all 
the files in the HandHeld directory are transmitted to the HandHeld. 

When this activity is complete and the DOS prompt shows, type: EXIT<Enter> 

This will return the PC to the GyHost system. 

Upon completion of the communication sub-system, GyHost returns to the 
'UpLoad/DownLoad' Menu at which point the user may <Esc> back to the main 
menu.  In certain cases, upon returning to the main menu, the databases are re-
opened.  This will show on the screen and is a normal process. 

Using the GyHand System 
With the current directory as GY, type the following to start the GyHand:  GY<Enter> 

This will invoke the GyHand program and present the Main Menu to the user. 

Refer to the GyHand User's Manual for instructions on how to use GyHand. 

Bear in mind the following points when using the GyHand system: 

• GyHand automatically re-indexes the databases following UpLoad and/or DownLoad to/from 
the Host PC so the user does not have to be concerned with this.  However, if the user wishes 
to ensure the databases are correctly sequenced: 
Type:  GY REINDEX <Enter> 

• The batch file for executing GyHand is GY.BAT.  Following the running of GyHand, the 
batch file deletes all files that have no extension (i.e.  ABCDEF.).  This precautionary step 
means that the user must not rely on any user files with no extension being retained in the GY 
directory. 

• It may be required to remove all the samples in the GY directory.  To do this, invoke the 
program as follows: 
GyHand PURGE<Enter> 
{Caution this will erase all samples from the HandHeld PC}  

• When GyHand is invoked with GY, the screen will show the databases being opened and/or 
re-indexed.  If this is not fully visible, or, if some of the menu appears to be off the top of the 
screen, it can be brought down by holding the paw key and < > until the top line of the menu 
is visible. 
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Upload Sample Data to Handheld 

<Enter> “2. UpLoad Sample Data to HandHeld”. 

The user is presented with a menu asking to select a HandHeld device - 
Ministry HandHeld or any other. 

Uploading from the Ministry HandHeld Computer 
• A set-up screen is presented to the user.  The instructions presented here should be 

followed. They start with ensuring that the HandHeld is physically connected from 
either COM1 or COM2 on the host PC to the left-hand connector on the Husky.  The 
user should follow the instructions given on the GyHost screen by entering the 
commands into the HandHeld.  Before 'Y' is pressed to signal the setup is complete, 
the user should see the 'HCOM' screen on the HandHeld showing the logo. 

• When 'Y' is pressed on GyHost, a selection box is presented.  This asks the 
user to confirm/change communication parameters.  Changing parameters 
should not normally be necessary after the initial setup.  If changes are 
required, <Tab> will present a picklist from which a suitable value can be 
selected by cursoring to it and <Enter>.  The initial value can be retained by 
escaping from this picklist.  When 'Y' is entered for 'Save&Exit' the 
communication program takes over.  The following is shown on a fresh 
screen: 

 Husky Command Line FileTransfer Utility Version1.05 
(c) Copyright Husky Computers Ltd. December 1992. 

• If communication fails during the UpLoad, text similar to that shown below 
will appear: 

  

• At this point, the upload can be (R)etried for the same module, or the whole 
upload process can be aborted with <Esc>. 

• Text on the screen to will show the user the progress of the transmission.  It 
will end with a report of the free disk space on the HandHeld PC drive C:. 
The message 
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|                                                          | 

|Review Communications                                     | 

|(R)etry the whole File UpLoad Procedure, or anything else to 
proceed| 

|__________________________________________________________| 

 will show regardless as to whether communication was successful or not. If 
communication could not be established with the HandHeld or a 
communication error occurred,  press  'R' to retry communications.  If all is 
well, press anything else. 

Uploading from any Other HandHeld Computers 

The 'Any Other' option is selected by cursoring to that option in the list and 
<Enter>. 

This causes GyHost to shell out to DOS with the current directory being 
HandHeld under the GyHost directory.  This directory is empty. 

Using whatever software is supplied with the particular HandHeld computer, the 
following files are transferred from the HandHeld to the HandHeld directory: 
 *.DBF All Files with the .dbf extension 
 *.  All Files with no extension 

When this activity is complete and the DOS prompt shows,  type: 
EXIT <Enter> 

This will return the PC to the GyHost system. 

Screen 6.  PC - Diskette 'DataTran' Transfer Menu 
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Features of the Sub-System 
The DataTran sub-system provides the mechanism for transferring samples between Hard Drive 
directories and between a Hard Drive directory and a diskette, displaying the contents of 
directories or diskettes, and deleting samples in the host directory on the Hard Drive. 

When Samples are transmitted between the Branch and the Regions, and the Regions and 
individual contractors, they are contained on a diskette.  The following diagram illustrates the  
movement of data among these three groups. 

Office
Regional

Office
Contractor

to the Region
Selected Previous Samples

to the Contractor

New Measurements
to the Region

New Measurements

Branch

Previous Branch Samples

to the Branch  
DataTran provides the mechanisms to achieve the above movement as well as facilities to assist the 
organization of the data within a users area of responsibility. 

The Branch office creates the initial diskettes containing the previous measurements outside of the 
scope of this system.  This data may, however, be processed at the Branch to distribute the samples 
among the various regional offices.  This processing will be identical to that used at the regional 
offices to distribute the data among the contractors and will be described in that context later.  
Similarly, the diskettes received by the Branch office from the regional offices may be processed to 
review and/or consolidate the data and this process will be described in the context of the regional 
offices receiving the diskette(s) from the contractors for consolidation and/or reporting. 

The Branch office will send to each regional office, diskettes containing the data for that region.  
The regional office will use the Import Previous Measurements DataTran facility to bring these 
data into his/her computer. 

The regional office will transfer to a holding directory, one for each contractor, the samples to be 
re measured for that contractor.  The Transfer Samples option from the DataTran menu will be 
used for this.  Individual diskettes, one for each contractor, can be created directly from these 
holding directories using the 'Export Previous Measurements' option from the DataTran menu.  The 
regional office will send this new previous samples diskette to the contractor. 

The contractor will, upon receiving the 'previous samples' diskette, load it into his/her system using 
the 'Import Previous Measurements' DataTran option. 

When the contractor has completed the measurements or re measurements, the 'Export New 
Measurements' DataTran option is used to create a diskette to return to the regional office. 

The regional office uses the 'Reload Samples' option to load these new measurements into 
previously created sub-directories.  The 'Transfer Samples' option is used to move these samples 
into the GyHost directory to enable the regional staff to review the new measurement data.  If the 
data is incomplete, the regional office can use the 'Export New Measurements' DataTran option to 
put the samples onto a diskette and return them to the contractor.  The previous measurements 
could be put onto a different diskette using the 'Export Previous Measurements' option as discussed 
above. 

The regional office can use the 'Transfer Samples' facility to move all of his/her contractor's sample 
measurements into one directory and then use the 'Export New Measurements' DataTran option to 
put these on a diskette to be sent to the Branch office. 

When this diskette is received at the Branch office, further consolidation can take place, before 
passing the resulting diskette out of this system to be input into the Ministry database. 
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Structure of Data on the Hard Drive and Diskette 

With certain exceptions in versions 2K and later, data on the user's Hard Drive 
will have a database structure (.dbf and .ntx files) while ALL data on diskettes 
will have a flat file format.  The exception is that it is now possible to export data 
to a dataset on a hard drive directory.  This will enable a large set of samples to 
be assembled for emailing (possibly a zipped version). 

In the same way, samples may be imported from Flat Files on the hard drive. 

DataTran will ensure that the above convention is maintained. 

All database files on the Hard Drive are standard Clipper/dBASE structure with 
the accompanying index files (.ntx suffix). 

The flat files will have a structure similar to their related database files, but 
without the database header or any field delimiters.  Fields are fixed length 
character format according to the definition in the databases, and each record is 
delimited with a carriage return (ASCII 13). 

<Enter>  “6. PC<>Diskette ‘DataTran’ Transfer Menu”.   The Transfer Menu 
allows seven options: 

1. 'Import Previous Measurements From FlatFile To HardDrive’ 

• This menu item is selected when it is required to copy previous 
measurements into the system.  This is required when the Regional office 
is importing the previous measurements from the Branch office or when 
a contractor is importing the previous measurements for his/her particular 
samples from the Regional office.  During the execution of this option, 
ALL previous measurements for each selected sample are deleted and 
ALL new measurements are replaced. 

• Next, the user is requested to insert the Original Branch Diskette as 
follows: 

• When the diskette containing the previous measurements has been 
inserted and any key pressed, the user is asked to specify from where the 
previous data is coming and to where it is to be copied: 

• The source diskette drive letter can be entered, or, alternatively, <Tab> 
can be pressed to show a list of possible drives.  In this second case, the 
appropriate drive is selected by cursoring to it and <Enter> is pressed to 
select it.  Whichever way the drive is selected, the choice is validated, 
and if it is invalid or the drive is empty, an error message will appear and 
re selection is required. 

• The source directory on the diskette containing the previous 
measurement dataset is next requested.  It can be entered by first pressing 
<\> followed by the path containing the directory.  If the dataset is in the 
root directory, just <\> on it's own will suffice.  Alternatively, <Tab> can 
be pressed to show a list of all directories on the diskette that contain a 
previous measurement dataset.  The user can cursor to the appropriate 
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directory and press <Enter> to select one of these.  Whichever way the 
directory is selected, the choice is validated, and, if it is invalid, an error 
message will appear and re-selection is required. 

• The destination hard drive or partition letter is requested.  It can be 
entered or <Tab> can be pressed to pop up a picklist of all possible hard 
drive/partitions available.  The user cursors to the appropriate one and 
selects it with <Enter>.  Whichever way the hard drive/partition is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The destination directory on the hard drive/partition selected above 
which is to receive the previous measurements is next requested.  It can 
be entered by first pressing <\> followed by the path defining the 
directory.  <Tab> can be pressed to show a picklist of all possible 
directories on the particular hard drive/partition.  The user can cursor to 
the required selection and select it with <Enter>.  Whichever way the 
directory is selected, the choice is validated and, if it is invalid, an error 
message will appear and re-selection is required. 

• The chosen selections are shown in the information window titled 
'Source and Destination'. 

• Following the selection of the source and destination drives and 
directories, the samples in the marker file (PspMeas.???) from the source 
drive-directory are shown in the 'Select Samples to Import' browse 
window.  By default, all samples showing are set to (Y)es for copying.  If 
any are NOT required, they can be de-selected by entering (N)o instead 
of (Y)es.  The cursor up and down keys are used to navigate among the 
displayed samples. <Enter> will terminate the de-selection process. 

• The program will now create temporary files from the flat diskette files 
in a temporary sub-directory TempDT.  After this, it will import the 
selected samples into the destination drive/directory from the temporary 
databases.  The user is kept informed of progress as these functions 
execute. 

• Upon completion of the above, the program reverts to the DataTran 
menu. 

At any point in the above process where user input is required, <Esc> can be 
pressed.  The effect of this is in most cases, to return to the previous user 
input screen where information can be changed.
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2. 'Export Previous Measurements From HardDrive To FlatFile  

This menu item is selected when it is required to copy previous measurement 
data from the Hard Drive to a diskette.  This is required when the Branch 
Office is exporting particular previous measurements to the Regional Offices 
or when a Regional Office is exporting particular previous measurements to 
the Contractor. 

• Next the user is requested to identify the drive and directory containing 
the previous measurements to be re-exported. 

• The source hard drive or partition letter is requested.  It can be entered or 
<Tab> can be pressed to pop up a picklist of all possible hard 
drive/partitions available.  The user cursors to the appropriate one and 
selects it with <Enter>.  Whichever way the hard drive/partition is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The source directory on the hard drive/partition selected above which 
contains the previous measurements is next requested.  It can be entered 
by first pressing <\> followed by the path defining the directory.  
Alternatively, <Tab> can be pressed to show a picklist of all directories 
that contain the PspMeas.dbf marker file on the particular hard 
drive/partition.  The user can cursor to the required selection and select it 
with <Enter>.  Whichever way the directory is selected, the choice is 
validated and, if it is invalid, an error message will appear and re-
selection is required. 

• The above selections are shown in the information window titled 'Source 
and Destination'. 

• Following the selection of the source drive and directory, the samples in 
the marker file from the source drive-directory are shown in the 'Select 
Samples to ReExport' browse window.  By default, all samples showing 
are set to (N)o for copying.  If any are required, they can be selected by 
entering (Y)es instead of (N)o.  The cursor up and down keys are used to 
navigate among the displayed samples.  Pressing <Enter> will terminate 
the selection process.  The program checks that all selected samples are 
of the same type.  If they are not, re selection is forced. 

• If the Re-exporting previous measurements samples are to be 
incorporated into an existing diskette dataset, that diskette should be 
mounted here.  If a new dataset is to be created for the Re-Exporting 
previous measurements, it is best to leave the diskette drive empty for 
now. 

• The user is required to enter the drive and directory into which the Re-
exporting dataset is to be merged.  If a new dataset is to be created for the 
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Re-Exporting previous measurements, the user should identify the drive, 
but set the directory to spaces. 

• The destination diskette drive letter can be entered, or, alternatively, 
<Tab> can be pressed to show a list of possible drives.  In this second 
case, the appropriate drive is selected by cursoring to it and <Enter> is 
pressed to select it.  Whichever way the drive is selected, the choice is 
validated, and if it is invalid or the drive is empty, an error message will 
appear and re selection is required. 

• The destination directory on the diskette containing the previous 
measurement dataset into which the ReExporting dataset is to be merged 
is next requested.  It can be entered by first pressing <\> followed by the 
path defining the directory.  If the dataset is in the root directory, just <\> 
on it's own will suffice.  Alternatively, <Tab> can be pressed to show a 
list of all directories on the diskette that contain a previous measurement 
dataset.  The user can cursor to the appropriate directory and press 
<Enter> to select one of these.  Whichever way the directory is selected, 
the choice is validated, and, if it is invalid, an error message will appear 
and re-selection is required.  As mentioned above, if a previous 
measurement ReExporting dataset is to be created, the directory should 
be changed to spaces at this time. 

• Following this process, the destination for the previous measurement 
ReExporting samples is shown in the 'Source and Destination' 
information window.  In the case of creating a new diskette dataset, the 
drive will show, but the directory will be blank and the diskette file 
extension will show as '.x??', where 'x' is the sample type of the 
ReExporting dataset. 

• Temporary database files are created in the TempDT sub directory for 
each of the flat files on the diskette.  If the requirement is to create new 
ReExported diskette files, empty databases are created in TempDT.  
Messages will show on the bottom line of the screen showing the 
creation/copying process. 

• The samples selected for export are shown in the ‘ReExport Previous 
Measurements’ window.  If there was an existing dataset on the diskette 
which was selected, this dataset will show in an adjacent window 
captioned previous diskette measurement.  If any of the datasets to be 
exported already exist in the diskette dataset, they are highlighted in the 
'ReExport previous measurements window.  This will enable the user to 
change the export? flag from (Y)es to (N)o if he or she wishes not to 
overwrite the specific diskette dataset sample with the new one. 

• The ReExport Progress report shows the copying of the source data into 
the temporary directory TempDT. 

• If a destination drive and directory has not yet been specified, it is 
requested. 
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• The destination diskette drive letter can be entered, or, alternatively, 
<Tab> can be pressed to show a list of possible drives.  In this second 
case, the appropriate drive is selected by cursoring to it and <Enter> is 
pressed to select it.  Whichever way the drive is selected, the choice is 
validated, and if it is invalid or the drive is empty, an error message will 
appear and re selection is required. 

• The destination directory on the diskette which is to receive the previous 
measurements is next requested.  It can be entered by first pressing <\> 
followed by the path defining the directory.  If the dataset is in the root 
directory, just <\> on it's own will suffice.  Alternatively, <Tab> can be 
pressed to show a list of all directories on the diskette that contain a 
previous measurement dataset.  The user can cursor to the appropriate 
directory and press <Enter> to select one of these.  Whichever way the 
directory is selected, the choice is validated, and, if it is invalid, an error 
message will appear and re-selection is required. 

• The destination extension for the diskette dataset is requested.  The first 
alphabetic character must be as displayed, the next two characters are at 
the discretion of the user. 

• The Source and Destination window is updated with the destination 
directory and dataset extension. 

• Finally, the progress of the copying of the assembled ReExport dataset 
from TempDT to the Diskette is shown on the bottom line of the display. 

• Upon completion of the above, the program reverts to the DataTran 
menu.  At any point in the above process where user input is required, 
<Esc> can be pressed.  The effect of this is, in most cases, to return to the 
previous user input screen where information can be changed. 

3. 'ReLoad New Measurements from the FlatFile to HardDrive. 

• This menu item is selected when it is required to re-load samples that 
have been exported.  It is used when a Contractor wishes to re-load his 
previously exported measurements or when either the Regional office or 
Branch office wishes to load new measurements sent by a contractor or 
Regional office. 

• The diskette and Hard Drive partition/drive and directory are identified 
using the window below. 

• The source diskette drive letter can be entered, or, alternatively, <Tab> 
can be pressed to show a list of possible drives.  In this second case, the 
appropriate drive is selected by cursoring to it and <Enter> is pressed to 
select it.  Whichever way the drive is selected, the choice is validated, 
and if it is invalid or the drive is empty, an error message will appear and 
re selection is required. 
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• The source directory on the diskette containing the exported dataset is 
next requested.  It can be entered by first pressing <\> followed by the 
path defining the directory.  If the dataset is in the root directory, just <\> 
on it's own will suffice.  Alternatively, <Tab> can be pressed to show a 
list of all directories on the diskette that contain a previous measurement 
dataset.  The user can cursor to the appropriate directory and press 
<Enter> to select one of these.  Whichever way the directory is selected, 
the choice is validated, and, if it is invalid, an error message will appear 
and re-selection is required. 

• The destination hard drive or partition letter is requested.  It can be 
entered or <Tab> can be pressed to pop up a picklist of all possible hard 
drive/partitions available.  The user cursors to the appropriate one and 
selects it with <Enter>.  Whichever way the hard drive/partition is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The destination directory on the hard drive/partition selected above 
which is to receive the previously exported measurements is next 
requested.  It can be entered by first pressing <\> followed by the path 
defining the directory.  <Tab> can be pressed to show a picklist of all 
possible directories on the particular hard drive/partition.  The user can 
cursor to the required selection and select it with <Enter>.  Whichever 
way the directory is selected, the choice is validated and, if it is invalid, 
an error message will appear and re-selection is required. 

• The above selections are show in the information window titled 'Source 
and Destination'. 

• Those samples that are NOT required to be reloaded should have the 
Extract field changed from (Y)es to (N)o.  Those that are required can be 
left as they are. 

• Pressing <Enter> will cause the system to create temporary database files 
in the TempDT sub-directory for the selected samples from the flat files 
on the diskette. 

• Note that if a remeasured sample is being reloaded, and the previous 
measurement is not on the hard drive, both measurements will be listed 
on the screen as indicated below, and the system will require the 
previous measurement. 

• The user may, change selected sample-measurements to (N)o.  Under 
normal circumstances both measurements of each sample should be 
(Y)es.  When the above window is satisfactorily set up, <Enter> is 
pressed. 

• After the original Branch diskette has been inserted, any key is pressed 
and a window appears requesting the diskette drive and directory. 
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• The source diskette drive letter can be entered, or, alternatively, <Tab> 
can be pressed to show a list of possible drives.  In this second case, the 
appropriate drive is selected by cursoring to it and <Enter> is pressed to 
select it.  Whichever way the drive is selected, the choice is validated, 
and if it is invalid or the drive is empty, an error message will appear and 
re selection is required. 

• The source directory on the diskette containing the original Branch 
dataset is next requested.  It can be entered by first pressing <\> followed 
by the path defining the directory.  If the dataset is in the root directory, 
just <\> on it's own will suffice.  Alternatively, <Tab> can be pressed to 
show a list of all directories on the diskette that contain a previous 
measurement dataset.  The user can cursor to the appropriate directory 
and press <Enter> to select one of these.  Whichever way the directory is 
selected, the choice is validated, and, if it is invalid, an error message 
will appear and re-selection is required. 

• Following this, the system appends to the temporary databases in 
TempDT, the previous measurement records from the original diskette 
dataset. 

• It only remains for the temporary databases to be incorporated into the 
specified destination directory.  The progress of this is shown in the Re-
Load Progress Report window. 

• Upon completion of the above, the program reverts to the DataTran 
menu. 

At any point in the above process where user input is required, <Esc> can be 
pressed.  The effect of this is, in most cases, to return to the previous user 
input screen where information can be changed. 

4. 'Export New Measurements from HardDrive to FlatFile. 

• This menu item is selected when it is required to copy new measurement 
data from the Hard Drive to a diskette.  This is required when the 
Contractor is exporting the new measurements to the Regional office or 
when the Regional office is exporting new measurements to the Branch 
office.  This process can add new sample measurements to or replace 
new sample measurements in an existing diskette dataset. 

• Next the user is requested to identify the drive/partition and directory 
containing the new measurements to be exported. 

• The hard drive or partition letter is requested.  It can be entered or <Tab> 
can be pressed to pop up a picklist of all possible hard drive/partitions 
available.  The user cursors to the appropriate one and selects it with 
<Enter>.  Whichever way the hard drive/partition is selected, the choice 
is validated and, if it is invalid, an error message will appear and re-
selection is required. 



 

72 GyHost/GyHand: A Data Collecting, Editing and Reporting System Version 2002 

• The source directory on the hard drive/partition selected above which 
contains the new measurements is next requested.  It can be entered by 
first pressing <\> followed by the path containing the directory.  
Alternatively, <Tab> can be pressed to show a picklist of all directories 
that contain the Sp_Meas.dbf marker file on the particular hard 
drive/partition.  The user can cursor to the required selection and select it 
with <Enter>.  Whichever way the directory is selected, the choice is 
validated and, if it is invalid, an error message will appear and re-
selection is required. 

• The above selections are shown in the information window titled 'Source 
and Destination'. 

• Following the selection of the source drive and directory, the samples in 
the marker file from the source drive-directory are shown in the 'Select 
Samples to Export' browse window.  By default, all samples showing are 
set to (N)o for copying.  If any are required, they can be selected by 
entering (Y)es instead of (N)o.  The cursor up and down keys are used to 
navigate among the displayed samples.  Pressing <Enter> will terminate 
the selection process.  The program checks that all selected samples are 
of the same type.  If they are not, re selection is forced. 

• If the exporting samples are to be incorporated into an existing diskette 
dataset, that diskette should be mounted here.  If a new dataset is to be 
created, it is best to leave the diskette drive empty for now. 

• The user is required to enter the drive and directory into which the 
exporting dataset is to be merged.  If a new dataset is to be created, the 
user should identify the drive, but set the directory to spaces. 

• The destination diskette drive letter can be entered, or, alternatively, 
<Tab> can be pressed to show a list of possible drives.  In this second 
case, the appropriate drive is selected by cursoring to it and <Enter> is 
pressed to select it.  Whichever way the drive is selected, the choice is 
validated, and if it is invalid or the drive is empty, an error message will 
appear and re selection is required. 

• The destination directory on the diskette containing the new 
measurement dataset into which the exporting dataset is to be merged is 
next requested.  It can be entered by first pressing <\> followed by the 
path defining the directory.  If the dataset is in the root directory, just <\> 
on it's own will suffice.  Alternatively, <Tab> can be pressed to show a 
list of all directories on the diskette that contain a previous measurement 
dataset.  The user can cursor to the appropriate directory and press 
<Enter> to select one of these.  Whichever way the directory is selected, 
the choice is validated, and, if it is invalid, an error message will appear 
and re-selection is required.  As mentioned above, if a new exporting 
dataset is to be created, the destination directory should be set empty at 
this time. 
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• For incorporating the measurements into an existing diskette dataset, 
temporary database files are created in the TempDT sub directory for 
each of the flat files on the diskette.  If the requirement is to create a new 
exported diskette dataset, empty databases are created in TempDT.  
Messages will show on the bottom line of the screen showing the 
creation/copying process. 

• The samples selected for export are shown in the ‘Export Samples’ 
window.  If there was an existing dataset on the diskette which was 
selected, this dataset will show in an adjacent window captioned 'Floppy 
Samples' following the pressing of <Tab> to select that window.  If any 
of the datasets to be exported already exist in the diskette dataset, they 
are highlighted in the 'Export Samples' window.  This will enable the 
user to change the export? flag from (Y)es to (N)o if he or she wishes not 
to overwrite the specific diskette dataset sample with the new one.  
<Enter> will begin extracting the specified sample measurements to the 
TempDT directory. 

• The Export Progress report shows the copying of the source data into the 
temporary directory TempDT. 

• If a destination drive and directory has not yet been specified, it is 
requested. 

• The destination diskette drive letter can be entered, or, alternatively, 
<Tab> can be pressed to show a list of possible drives.  In this second 
case, the appropriate drive is selected by cursoring to it and <Enter> is 
pressed to select it.  Whichever way the drive is selected, the choice is 
validated, and if it is invalid or the drive is empty, an error message will 
appear and re selection is required. 

• The destination directory on the diskette which is to receive the new 
measurements is next requested.  It can be entered by first pressing <\> 
followed by the path defining the directory.  If the dataset is in the root 
directory, just <\> on it's own will suffice.  Alternatively, <Tab> can be 
pressed to show a list of all directories on the diskette that contain a 
previous measurement dataset.  The user can cursor to the appropriate 
directory and press <Enter> to select one of these.  Whichever way the 
directory is selected, the choice is validated, and, if it is invalid, an error 
message will appear and re-selection is required. 

• The Source and Destination window is updated with the destination 
directory and dataset extension. 

• Finally, the progress of the copying of the assembled export dataset from 
TempDT to the Diskette is shown on the bottom line of the display. 

• Upon completion of the above, the program reverts to the DataTran 
menu. 
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At any point in the above process where user input is required, <Esc> can be 
pressed.  The effect of this is, in most cases, to return to the previous user 
input screen where information can be changed. 

5. 'Transfer .DBF Samples Between HardDrive Directories’. 

• This menu item is selected when it is required to transfer or copy selected 
samples between directories on the Hard Drive.  Transfer implies 
deleting the original after the copy process is completed; copy implies 
retaining the original after the copy is completed. The procedure is as 
follows: 

• The source and destination drives and directories are specified. 

• The source hard drive or partition letter is requested.  It can be entered or 
<Tab> can be pressed to pop up a picklist of all possible hard 
drive/partitions available.  The user cursors to the appropriate one and 
selects it with <Enter>.  Whichever way the hard drive/partition is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The source directory on the hard drive/partition selected above which 
contains the samples to be transferred is next requested.  It can be entered 
by first pressing <\> followed by the path defining the directory.  <Tab> 
can be pressed to show a picklist of all possible directories on the 
particular hard drive/partition.  The user can cursor to the required 
selection and select it with <Enter>.  Whichever way the directory is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The destination hard drive or partition letter is requested.  It can be 
entered or <Tab> can be pressed to pop up a picklist of all possible hard 
drive/partitions available.  The user cursors to the appropriate one and 
selects it with <Enter>.  Whichever way the hard drive/partition is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• The destination directory on the hard drive/partition selected above into 
which the samples are to be transferred is next requested.  It can be 
entered by first pressing <\> followed by the path defining the directory.  
<Tab> can be pressed to show a picklist of all possible directories on the 
particular hard drive/partition.  The user can cursor to the required 
selection and select it with <Enter>.  Whichever way the directory is 
selected, the choice is validated and, if it is invalid, an error message will 
appear and re-selection is required. 

• When the selection is complete, the user is asked if the samples are to be 
deleted from the source after the transfer is complete. 
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• All the samples from the source directory are presented in the transfer 
window with the Extract status defaulted to (N)o.  Those samples to 
transfer will need to have their status changed to (Y)es. 

• When all the required samples have had their Extract status changed, 
<Enter> is pressed and the transfer progress window is shown while the 
copying occurs.  Following the copy process, if a transfer was requested 
(as opposed to a copy), confirmation of the deletion of the source 
samples is required. 

• If (Y)es is pressed, a window shows the progress of the source deletion. 

• Upon completion of the above, the program reverts to the DataTran 
menu. 

At any point in the above process where user input is required, <Esc> can be 
pressed.  The effect of this is, in most cases, to return to the previous user 
input screen where information can be changed. 

6. 'Delete Samples From Host Directory’. 

This menu item is selected when it is required to delete selected samples in 
the host directory.   

• All samples in the directory that you are presently in, are presented in a 
window.  The most recent measurement number for these samples is 
shown in brackets alongside the word ALL.  ALL is shown to reinforce 
the fact that ALL measurements will be deleted. 

• When those samples required to be deleted are selected by setting the 
extract status to (Y)es, <Enter> is pressed.  This window asks the user if 
he or she is sure the deletion should proceed. 

• A response of (Y)es will delete the required samples. 

• Upon completion, the program reverts to the DataTran menu. 

• At any point in the above process where user input is required, <Esc> 
can be pressed.  The effect of this is, in most cases, to return to the 
previous user input screen where information can be changed. 

7. 'Display Sample Identification’. 

This menu item is selected when it is required to display samples on the Hard 
Drive or a Diskette.   

• If a display of diskette samples is required, that diskette must be inserted 
prior to the entry of the drive and directory. 

• The source diskette drive or the Hard Drive partition letter can be 
entered, or, alternatively, <Tab> can be pressed to show a list of possible 
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drives and partitions.  In this second case, the appropriate drive is 
selected from the displayed picklist by cursoring to it and pressing 
<Enter>.  Whichever way the drive or partition is selected, the choice is 
validated, and if it is invalid or the drive is empty, an error message will 
appear and re selection is required. 

• The source directory on the diskette or hard drive containing the dataset 
to be displayed is next requested.  It can be entered by first pressing <\> 
followed by the path defining the directory.  If the dataset is in the root 
directory, just <\> on it's own will suffice.  Alternatively, <Tab> can be 
pressed to show a list of all directories on the diskette that contain a 
previous or current measurement dataset.  The user can cursor to the 
appropriate directory and press <Enter> to select one of these.  
Whichever way the directory is selected, the choice is validated, and, if it 
is invalid, an error message will appear and re-selection is required. 

• Having selected the source drive and directory, they are displayed in the 
'Source' window. 

• All the Samples that comprise the dataset on the selected drive - 
directory are now displayed in the Sample Display.  The measurement 
number refers to the highest number in that dataset. 

• Upon completion of the above, the program reverts to the DataTran 
menu. 

At any point in the above process where user input is required, <Esc> can be 
pressed.  The effect of this is, in most cases, to return to the previous user 
input screen where information can be changed. 

Screen 7.  FPC Matrix File Extract 

<Enter>  “7. FPC Matrix File Extract” to prepare FPC Matrix Establishment 
Reports at the end of the field season, for sample type ‘G’ only. 

The user is asked if samples are ready for extract and, if yes, is asked to select 
those samples for extraction. 

Once done, the user has three choices: 
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1. FPC Matrix File Extract - Prepares reports of previously selected 
samples and asks the user for destination. 
 
Note:  If any missing data is found, the program automatically prepares 
option 3. FPC Matrix File Extract Error Report. 

2. Yearly Establishment List - Prepares list of established samples which 
can be printed or seen on the screen. 

3. FPC Matrix File Extract Error Report - Prepares a list of any missing 
data encountered which can be printed or seen on the screen. 


